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Preface 
The Oracle|Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology 
Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) contains the 
latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation 
folder available on your network from which you can access the Oracle|Agile documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. 
This program can be downloaded from the Adobe Web site (http://www.adobe.com). 

The Oracle Technology Network (OTN) Web site 
(http://www.oracle.com/technology/documentation/agile.html) can be accessed through Help > 
Manuals in both the Agile Web Client and the Agile Java Client. If you need additional assistance or 
information, please contact support (http://www.oracle.com/agile/support.html) 
(http://www.oracle.com/agile/support.html) for assistance. 

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please 
have ready the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Documentation Accessibility  

Our goal is to make Oracle products, services, and supporting documentation accessible, with good 
usability, to the disabled community. To that end, our documentation includes features that make 
information available to users of assistive technology. This documentation is available in HTML 
format, and contains markup to facilitate access by the disabled community. Accessibility standards 
will continue to evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be accessible to 
all of our customers. For more information, visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/ http://www.oracle.com/accessibility/.  

Readme 

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html). 

Agile Training Aids 

Go to the Oracle University Web page 
(http://www.oracle.com/education/chooser/selectcountry_new.html) for more information on Agile 

http://www.oracle.com/technology/documentation/agile.html
http://www.adobe.com/
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/accessibility/
http://www.oracle.com/accessibility/
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/education/chooser/selectcountry_new.html


 

Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  
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Chapter 1 

Overview of Agile Database Installation 

This chapter includes the following: 

 Agile System Requirements ................................................................................................................................ 1 
 Database Hardware Configuration ...................................................................................................................... 3 
 RAID Configuration.............................................................................................................................................. 5 
 Disk I/O Configurations........................................................................................................................................ 5 

 
 

Agile System Requirements 
Depending on the size and type of network system in each site, Agile PLM 9.2.2.3 may be deployed 
in different configurations. The amount of time required to complete an installation depends on the 
complexity of your Agile PLM implementation.       

Note For installations using a certified localized language, all server components must be 
installed on computers running the same localized OS. Clients can be running on the 
same localized OS or English OS. For detailed information about using Agile with 
international operating systems, contact the Agile support Web site. 

Agile can be distributed over a wide-area network with multiple servers or can be limited to one or 
two server computers with several client computers. In the latter case, Agile can usually be installed 
within a half day. However, network-based systems are inherently complex, and some installations 
require additional time. 

Agile recommends installing the Oracle database on a separate computer than the other Agile 
components. 

It is acceptable to install multiple server components on the same computer if the additional 
resources are not available. However, the minimum hardware requirements must be increased 
based on the number of server components installed on a single computer. 

Operating System Requirements 

You should install only supported versions of Agile components that are within the same release. 
You should not attempt to install Agile components on unspecified operating systems. Contact your 
Agile Solutions Consultant or Agile Technical Support for special requirements.        

Operat ing System Vers ion 

Microsoft Windows 2003 

Solaris Release 9 and 10 

Linux RedHat Linux 4.0 
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Hardware Requirements 

Before you can install Agile server components, you must have at least 1 GB of available disk 
space available where the OS is installed, in addition to the minimum disk space requirements 
specified in the Capacity Planning Guide.           

Important Agile computers and databases should be dedicated to Agile and should not have other 
software installed, unless otherwise specified. Do not attempt to include other database 
schemas or use the Agile host server as the primary domain controller (PDC) or dynamic 
host configuration protocol (DHCP) server. 

Note Disk compression must be disabled on Agile computers. 

When choosing a hardware configuration, consider the number of total users, the number of 
concurrent users, the size of your database, the number of ECOs processed per day, and overall 
activity level. If you have questions about your system, Agile Technical Support or your Agile 
Solutions Consultant can give guidance on whether you have small, medium, large, or extra-large 
system requirements. 

It is required that the computer on which you are installing Agile components and the Oracle 
database have at least two physical drives or two partitions. This allows you to place the operating 
system on one drive and use the other drive for Agile or Oracle components. 

Note If you have only one drive or one partition, you will not be able to use the Agile Database 
Configuration utility. 

The tables below provide summary information for minimum hardware requirements based on 
database size. 

Hardware  Windows and L inux Solar is  

CPU Dual, 1.8 GHz Intel Xeon Dual 900MHz Ultra Sparc III 

RAM (GB) 1 1 

Number and size of disks (partitions) Four 18 GB Four 18 GB 

 

Hardware  Windows and L inux Solar is  

CPU Dual, 1.8 GHz Intel Xeon Dual 900 MHz Ultra Sparc 

RAM (GB) 2 2 

Number and size of disks (partitions) Four 18 GB Four 18 GB 

 

Hardware  Windows and L inux Solar is  

CPU Four, 1.8 GHz Intel Xeon Four 900 MHz Ultra Sparc III 

RAM (GB) 4 4 

Number and size of disks (partitions) Nine 18 GB Nine 18 GB 
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Hardware  Windows and L inux Solar is  

CPU Eight, 1.8 GHz Intel Xeon Eight 900 MHz Ultra Sparc III 

RAM (GB) 8 8 

Number and size of disks (partitions) Twelve 18 GB Twelve 18 GB 

 

The Agile database uses Oracle 9.2.0.1.0 or 10.2.0.1. An email system based on SMTP or SMTP 
gateway is also required. Recommended database hardware depends on your Agile system 
configuration. 

If you have only single processor computers and anticipate high network traffic, then the database 
and Agile Application Server should be installed on two different computers to avoid competition for 
resources on a single computer, which would outweigh any advantage gained from reduced 
network traffic. 

Oracle recommends separate disks for the operating system and database. 

Database Hardware Configuration 
Agile uses four database configurations (A through D), as shown in the following table. In addition, 
The previous tables provide the minimum hardware configuration based on the database sizing 
model. Each database configuration provides necessary hardware resources to support the Agile 
database sizing model. 

Taking into account the hardware requirements specified in the following table, each configuration is 
intended for a specific database sizing model. The minimum hardware requirements should be 
followed to satisfy the Agile database installation. To increase the scalability and concurrency for 
any configuration, provide additional CPUs, RAM, and disk space. 

 Configuration A provides the initial hardware resources for implementing the small database 
sizing model. 

 Configuration B provides the minimum hardware resources for implementing the medium 
(regular) database sizing model. 

 Configuration C provides the minimum hardware resources for implementing the large 
database sizing model.   

 Configuration D provides the minimum hardware resources for implementing the extra-large 
database sizing model. 
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# o
f d

isk
s 

CP
U 

RA
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# o
f d

isk
s 

D Solaris/
Windows 
/Linux 

1000 8 8 
GB 

9 12 12 
GB 

9 16 16 
GB 

12 24 24 
GB 

15 

C Solaris/
Windows 
/Linux 

500 4 4 
GB 

4 8 8 
GB 

9 8 8 
GB 

11 12 12
GB 

12 

EXTRA LARGEB Solaris/
Windows 
/Linux 

250 4 2 
GB 

4 8 4 
GB 

4 4 4 
GB 

9 

A Solaris/
Windows 
/Linux 

100 2 1 
GB 

4 2 2 
GB 

4 

De-
mo 

Windows
/Linux 

1 1 .5 
GB 

1 

DATABASE SIZING MODEL SMALL

MEDIUM

LARGE  

 

You should take the platform into consideration when you select the Agile database configuration. 
When you choose the Windows platform for database deployment, you should consider the 
potential that additional resources will be required for scaling the application within one or two 
years. Agile recommends using the Windows platform for a database with relatively moderate 
growth. For enterprise-level usage with a high-growth potential, it may be beneficial to adopt the 
Solaris or Linux platform, which is easily expanded in CPUs and RAM. 

Depending on the database sizing and configuration model you follow, the database could 
potentially support the following: 

 Small database model 
 Configuration A supports up to 100 concurrent users 
 Configuration B supports up to 250 concurrent users 
 Configuration C supports up to 500 concurrent users 
 Configuration D supports up to 1,000 concurrent users 

 dMe ium (regular) database model 
 Configuration A supports up to 100 concurrent users 
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 Configuration B supports up to 250 concurrent users 
 Configuration C supports up to 500 concurrent users 
 Configuration D supports up to 1,000 concurrent users 

 rg

 
 Configuration C supports up to 500 concurrent users 

p to 1,000 concurrent users 

, the 
 also be noted that RAID 0+1 is 

RAID 5 is highly discouraged for Agile PLM database deployment. At a minimum, redo logs should 
 5. 

figurations by spreading the I/O burden 
or the Oracle 

DATA1, 

Note espace, SYSAUX, available with Oracle 10g. If you are using an 

La e database model 

 Configuration C supports up to 500 concurrent users 
 Configuration B supports up to 250 concurrent users 

 Configuration D supports up to 1,000 concurrent users 

Extra-large database model 

 Configuration D supports u
 

RAID Configuration 
RAID 1 mirroring is highly recommended because of its high tolerance for hardware fault. Although 
the following section refers to one-disk, four-disk, nine-disk, and twelve-disk configurations
RAID 1 configuration doubles the number of disks installed. It should
the best configuration in a nine-disk or twelve-disk configuration. In fact, such a hardware 
configuration normally requires an external disk storage enclosure. 

not be stored in disks configured with RAID

Disk I/O Configurations 
While the proper sizing of extents minimizes dynamic extensions in the same segments, disk I/O 
contention within the same logical tablespace or physical data file can also be harmful.          

You can improve disk I/O performance for multiple disk con
across multiple disk devices. The following sections describe the use of multiple disks f
database server. It is always advisable to use more disks. 

There are eight tablespaces in the Agile PLM database configuration: AGILE_
AGILE_DATA2, AGILE_DATA3, and AGILE_DATA4 for Agile table segments, and AGILE_INDX1, 
AGILE_INDX2, AGILE_INDX3, and AGILE_INDX4 for Agile index segments. 

There is an additional tabl
Oracle 10g database, add the SYSAUX tablespace to the same drive as the SYSTEM 
tablespace.  
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Disks 
 (no  

RAID)  

Disks  
(RAID 1)  

Dr ive /Mount  
Point  

Orac le_Home Tablespaces Redo 
Logf i les  

Control  
f i les  

Disk 0 Disk 0/1 D or  
/u01 

Oracle_Home SYSTEM 

TOOLS 

UNDO 

TEMP 

USERS 

INDX 

AGILE_DATA1 

AGILE_DATA2 

AGILE_DATA3 

AGILE_DATA4 

AGILE_INDX1 

AGILE_INDX2 

AGILE_INDX3 

AGILE_INDX4 

LOG1 

LOG2 

LOG3 

LOG4 

Control 
file01 

Control 
file02 

Control 
file03 

 
 

One-Disk 

A one-disk configuration is best for a demonstration, preproduction, and testing environment. This 
configuration results in disk I/O contention. In addition, as both usage and database size increase, 
performance significantly declines. The one-disk configuration is intended for demo database 
applications only, and the configuration can be implemented as shown.         

There is no beneficial gain from OFA for the one-disk configuration from the perspective of disk I/O 
contention. There should be no significant impact on a current production database if you 
implement the default Oracle settings with a one-disk configuration. 

Four-Disk Configuration 

A four-disk configuration is best for an enterprise-level implementation of Agile. A four-disk 
configuration spreads the various data files, control files, and redo log files across multiple disk 
devices.         

First of all, the three control files can be mirrored onto three different disks for best recovery 
protection. 

Second, all potential I/O demand-intensive data files can be distributed onto their own separate 
disk. Redo log files are partially isolated from the rest of the data files, as the log files can cause 
significant I/O contention during transactions if they are sharing disks with other data files. The 
UNDO data file is separated from the schema data files and log files as well, so I/O contention 
during import and upgrade can be minimized. 
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Third, the Agile schema tablespaces can be isolated from the rest of the SYSTEM, TEMP, TOOLS, 
and UNDO data files.  

Disks  
(no  

RAID)  

Disks  
(RAID 1)  

Dr ive /Mount  
Point  

Orac le_Home Tablespaces Redo 
Logf i le

s  

Control  
f i les  

Disk 0 Disk 0/1 D or /u01 Oracle_Home SYSTEM/TOOL/UNDO  Control 
file01 

Disk 1 Disk 2/3 E or /u02  TEMP/USERS/INDX Archive 
log file 

Control 
file02 

Disk 2 Disk 4/5 F or /u03   AGILE_INDX1 

AGILE_INDX2 

AGILE_INDX3 

AGILE_INDX4 

 
LOG1/2/
3/4 

Control 
file03 

Disk 3 Disk 6/7 G or /u04  AGILE_DATA1 

AGILE_DATA2 

AGILE_DATA3 

AGILE_DATA4 

   

 

The four-disk configuration shown is recommended. For production database sites, the four-disk 
configuration represents the minimum requirements for an OFA implementation and provides the 
minimum hardware configuration for performance tuning. 

Nine-Disk Configuration 

In addition to the advantages associated with a four-disk configuration, a nine-disk configuration 
supports an enterprise-level implementation of Agile by further spreading various data files and redo 
log files across multiple disk devices.       

Application schema can obtain additional performance gains in terms of I/O load spread by further 
separating the AGILE_DATA1, AGILE_DATA2, AGILE_DATA3, AGILE_DATA4 and AGILE_INDX1, 
AGILE_INDX2, AGILE_INDX3, AGILE_INDX4 data files because of potential I/O contention 
between the AGILE_DATA data files and AGILE_INDX data files. For supporting a full text search 
content index, a complete separation of potential large datafiles in its own disk spindle should help 
I/O contention as physical disk I/O is inevitable, due to the share size of data, as shown in the 
following table.    

Disks 
(no  

RAID)  

Disks  
(RAID 1)  

Dr ive /Mount  
Point  

Orac le_Home Tablespaces Redo 
Logf i les  

Control  
f i les  

Disk 0 Disk 0/1 C or /u01 Oracle_Home SYSTEM/TOOL/UND
O 

  

Disk 1 Disk 2/3 D or /u02  TEMP/USERS/INDX  Control 
file01 
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Disks 
(no  

RAID)  

Disks  
(RAID 1)  

Dr ive /Mount  
Point  

Orac le_Home Tablespaces Redo Control  
f i les  Logf i les  

Disk 2 Disk 4/5 E or /u03   LOG 
1/2/3/4 

Control 
file02 

Disk 3 Disk 6/7 F or /u04   Archive 
log file 

Control 
file03 

Disk 4 Disk 8/9 G or /u05  AGILE_DATA1 

AGILE_INDX2 

  

Disk 5 Disk 
10/11 

H or /u06  AGILE_DATA2 

AGILE_INDX3 

  

Disk 6 Disk 
12/13 

I or /u07  AGILE_DATA3 

AGILE_INDX1 

  

Disk 7 Disk 
14/15 

J or /u08  AGILE_DATA4   

Disk 8 Disk 
16/17 

K or /u09  AGILE_INDX4   

 
 

Twelve-Disk Configuration 

Further separating the AGILE_DATA and AGILE_INDX tablespaces, twelve-disk configurations can 
be implemented as shown. This results in completely independent spindles for AGILE_DATA1, 
AGILE_DATA2, AGILE_DATA3, AGILE_DATA4 and AGILE_INDX1, AGILE_INDX2, 
AGILE_INDX3, AGILE_INDX4. 

Disks 
(no  

RAID)  

Disks  
(RAID 

1 )  

Dr ives/Mou
nt  Points  

Orac le_Home Tablespaces Redo 
Logf i les  

Control  
f i les  

Disk 0 Disk 0/1 C or /u01 Oracle_Home    

Disk 1 Disk 2/3 D or /u02  SYSTEM/TOOL/UND
O/TEMP/INDX 

 Control 
file01 

Disk 2 Disk 4/5 E or /u03   LOG 
1/2/3/4 

Control 
file02 

Disk 3 Disk 6/7 F or /u04  USERS Archive 
logfile 

Control 
file03 

Disk 4 Disk 8/9 G or /u05  AGILE_DATA1   

Disk 5 Disk 
10/11 

H or /u06  AGILE_DATA2   

Disk 6 Disk 
12/13 

I or /u07  AGILE_DATA3   

Page - 8 Agile Product Lifecycle Management 

 

 



 Chapter 1  
 
 

Disks 
(no  

RAID)  

Disks  
(RAID 

1 )  

Dr ives/Mou
nt  Points  

Orac le_Home Tablespaces Redo Control  
f i les  Logf i les  

Disk 7 Disk 
14/15 

J or /u08  AGILE_DATA4   

Disk 8 Disk 
16/17 

K or /u09  AGILE_INDX1   

Disk 9 Disk 
18/19 

L or /u10  AGILE_INDX2   

Disk 10 Disk 
20/21 

M or /u11  AGILE_INDX3   

Disk 11 Disk 
22/23 

N or /u12  AGILE_INDX4   
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Chapter 2 

Installing the Agile Database on Windows 

This chapter includes the following: 

 Installation Notes ................................................................................................................................................. 11 
 Copying the Agile CDs......................................................................................................................................... 11 
 Installing the Oracle Database............................................................................................................................. 11 
 Starting the Installer............................................................................................................................................. 12 
 Using the Agile Database Configuration Utility .................................................................................................... 13 
 Adding and Configuring the Listener ................................................................................................................... 14 
 Configuring Oracle Database Control (Optional) ................................................................................................. 15 

Note Unless specified otherwise, all references to Windows specifically require Windows 2003 
with Service Pack 2. Service Packs are available on Microsoft’s Web site, 
www.microsoft.com.        

 

Installation Notes 
For best results, as you install: 

 Follow directions in the order in which they are given. Do not attempt to install any components 
out of sequence.    

 Oracle passwords are not case-sensitive. Agile passwords are case-sensitive. All other text 
entries, such as schema names and folder names, are not case-sensitive. To avoid confusion, 
all passwords and text entries in this guide appear in lowercase and should be typed as shown. 

 When prompted for a hostname, type the short name for the host, not the fully qualified name. 
For example, if a host is named dbo, type dbo, not dbo.agile.com. 

 

Copying the Agile CDs 
Before installing Agile PLM 9.2.2.3, the contents of both CDs should be copied to a local directory 
with the same file structure as the original CDs. The Platform directory on CD #2 must be copied on 
the same directory level as the setup.exe file. 

Installing the Oracle Database 
Use the instructions in Installing Oracle 9i (on page 57) to install Oracle 9i Release 2 or Installing 
Oracle 10g (on page 63) to install Oracle 10g Release 2, if the database is not already installed. 
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Starting the Installer 
The installation of all components follows the same initial process up through the panel where you 
select the components to install.      

Important To run the Agile installation program, you must have at least 1200MB of available disk 
space on Windows on the drive where your default Temp directory is located. 

Note Disable virus protection, if you are using it. Components used in the installer can be 
falsely identified as being infected and lock up the installation. You can turn the virus 
protection on after the installation is complete. 

To start the Agile PLM installer on Windows: 

1. Log in to the computer using a login with local Administrator permissions. 

2. In the Agile installation directory for Windows, double-click the setup.exe file. 

Note If there is insufficient disk space available to complete the installation, you will 
be prompted for another location. Click Choose, select another drive, Click OK, 
and the installer will start. 

After a few moments, the Welcome screen appears. 

During Agile PLM installation, you must select components to install. The list of components you 
can install is based on your license key. Choose Database Server and Agile PLM when this list displays 
to install and create the Agile database with the Agile Database Configuration Utility. 

Installer Buttons 

Agile PLM installation panels have the following buttons: 

 Cancel — Exits from the installation program. 

 Help — Displays online help. 

 Previous — Returns to the previous step. 

 Next — Proceeds to the next step. 

 Install — Starts installing. The Install button appears only on the Pre-Installation Summary 
panel, after you have specified installation options. 

 Done — Exits from the installation program. On Windows, after installing certain components 
you can choose whether to restart the computer when you click Done. The Done button appears 
only on the Install Complete panel, after you have finished installing. 

 

Installer Online Help 

Each installation panel has online help. At any time during installation, you can click Help for more 
information about the panel’s options. 

If you leave the online help window open, it will be updated when you proceed through the installer 
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panels. Otherwise, click Close at the bottom of the help window. 

Using the Agile Database Configuration Utility 
The Agile database configuration utility creates and configures the database used by Agile.  

1.        

To configure the database: 

In the Agile PLM installer, click Install. The Database Configuration Utility appears. 

Note The installer creates and configures an Agile database using the default 
values. 

All h ou 
must select a

ard drive indicators show the available disk space. If the space is a negative value, y
nother hard drive. 

Important If you change a default value, you must click in the field to ensure that the 
change is activated. 

2. In the Destination Location dialog box, accept the default location. This is the location where 
files are placed during the database installation. Click Next. 

3. ng database to 
te s

In the Database Size Estimate dialog box, new Agile customers without an existi
migra hould accept the default (Small). Click Next. 

Note Refer to the Capacity Planning Guide for database sizing information. 

4. 
were installed. If you have 

5. ID, you 

se an existing SID, you must remove it before you can re-use it.  Click . 

6.  Agile User Information dialog box, accept the default values as 

a Name is agile 

7.  
sufficient space available that allow you to distribute the files across multiple hard drives. If you 

lick 
Next. 

In the Oracle Home dialog box, accept the default unless there is insufficient disk space 
available. This is the location where the Oracle database files 
multiple Oracle Homes, make sure the correct Oracle Home is selected in the list before 
continuing with the Database Configuration Utility. Click Next. 
In the Oracle SID dialog box, accept the default agile9 SID. If you want to change the S
must use an ID less than or equal to 8 characters to uniquely identify the Oracle SID. If you 
want to u Next
In the Database Security and
follows:  
 Sys Password is oracle 
 System Password is manager 
 Agile Schem
 Agile Schema Password is tartan 

Click Next.          
In the Tablespaces dialog box, accept the default, unless you have additional hard drives with

select a different drive location, click the letter of the drive to make sure it is selected. C

Note Use the tables in “Disk I/O Configurations” to determine how to distribute the 
files. 

8. In the Redo Log Files and Control Files dialog boxes, accept the default, unless you have 
additional hard drives with sufficient space available that allow you to distribute the files across 
multiple hard drives. Click Next. 
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9. If you accept the default location for the files on one drive, a message appears notifying you 
about distributing the files across multiple drives (mirroring protection). If this is not an option
click 

, 
. Otherwise, click Back and reassign files to different hard drives. 

rive. Click 

11. In the Ora ox, accept the default character set UTF8. Click Next. 

t, refer to the Oracle 

Next
10. In the Archive Log File dialog box, accept the default, unless you have additional hard drives 

with sufficient space available that allow you to store the file on a different hard d
Next. 

cle Language Support dialog b

Note For additional information about language suppor
Globalization Support Guide. 

A Command Prompt window displays briefly. 

12. You are p

The script runs in a Command Prompt window for awhile. The window automatically closes 
 the database is installed. 

rompted to install the Agile database. Click Next. 

when

t 

h Oracle Text. Because of 
this feature, there is a fixed account, CTXSYS, and its schema used by the Agile schema. For 

rd from its default, CTXSYS, to 
tion. 

istener 

configure . 

ase on the same machine, you only need to add the 

Important Change all Oracle database user passwords after you have created the Agile database. I
is recommended to change these passwords periodically for security purposes. 

Agile supports Full Text Search (FTS). FTS is a feature enabled throug

security purposes, you can change the CTXSYS account passwo
one of your choosing after Agile database creation and configura

Adding and Configuring the L
If this is the first time Oracle has been installed on the current computer, you need to add and 

 a new address to the Listener settings

Note If you are upgrading your Agile datab
new database to the existing listener. 

To add a new Listener address on Oracle 9i:         

1. Start the Oracle Net Configuration Assistant by choosing Start > Programs > Oracle -OraHome92 > 
t. 

 Next. 
n the Listener Name dialog box. Click Next. 

 Next. 

Configuration and Migration Tools > Net Configuration Assistan
2. In the Oracle Net Configuration Assistant window, select Listener Configuration. Click Next. 
3. Select Add to add a listener to the database. Click

4. Accept the default listener name, LISTENER, i

5. Accept TCP as the Selected Protocol. Click Next. 
6. Accept the standard port of 1521. Click Next. 
7. Select No when asked to configure another listener. Click Next. 
8. The Listener configuration is complete. Click

9. Click Finish to close the Oracle Net Configuration Assistant window. 
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To configure the new Listener address on Oracle 9i: 

1. Start the Oracle Net Manager by choosing Start > All Programs > Oracle  

2. anager window, double-click the Local folder and select the Listeners folder. 

3. 

4. le tening Locations drop-down list. 

x that appears, make the following changes: 
ba

 Oracl

 different home directory during 

- OraHome92 > Configuration and Migration Tools > Net Manager. 
In the Oracle Net M

Click the name of the newly created listener, LISTENER. 

Se ct Database Services in the Lis
Click Add Database. 

In the dialog bo
 Glo l Database Name: agile9 

e Home Directory: oracle_home 
 SID: agile9 

Note If you used a different global database name or
the database installation, change the information as appropriate. 

5. 

 All Programs > Oracle  
me1  > Net Manager. 

2. he Local folder and select the Listeners folder. 

Choose File > Save Network Configuration to save your changes. 

To add and configure a new Listener address on Oracle 10g:         

1. Start the Ora et Manager by choosing cle N Start >
- OraDb10g_ho  > Configuration and Migration Tools
In the Oracle Net Manager window, double-click t

3. Click Create  in the toolbar to add a listener. 

The Choose Listener Name dialog box appears. 

4. 

5. le g Locations drop-down list. 

ars, make the following changes: 
ba

 Oracle Home Di

Click OK. 

Se ct Database Services in the Listenin
a. Click Add Database. 

In the dialog box that appe
 Glo l Database Name: agile9 

rectory: oracle_home 
 SID: agile9 

Note If you used a different global database name or different home directory during 
the database installation, change the information as appropriate. 

6. Choose File > Save Network Configuration to save your changes. 

7. Open a Command Prompt window and type lsnrctl reload to restart the database listener. 
 

Configuring Oracle Database Control (Optional) 

man rformance tuning. 
In Oracle 10g, you can use Database Control to perform many database administration and 

agement tasks including SQL pe
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To configure the Oracle network connection: 

tion Tools > 
. 

2. 

k Next. 

ust created. Click Next. 

7. 

ke a note of this URL 

11. Open a web browser and enter the Database Control URL. 

12. Type the User Name and Password of the Agile database. Click Login. 

13. Click I agree to accept the license agreement and display the Database Control page. 

You have finished installing and configuring the Agile PLM database. 

1. Choose Start > All Programs > Oracle - OraDb10g-home1 > Configuration and Migra
Database Configuration Assistant
The Welcome screen appears. 

Click Next. 
3. Choose Configure Database Options on the Operations page. Clic

The Database page appears 

4. Select the agile9 database you j

The Management Options page appears. 

5. Check Configure the Database with Enterprise Manager. Click Next. 
The Database Content page appears. 

6. Accept the defaults. Click Next. 
The Database Credentials page appears. 

Enter a password for the DBSNMP and SYSMAN users. Click Next. 
The Connection Mode page appears. 

8. Select Dedicated Server Mode. Click Finish. 

9. Click OK for confirmation. Database configuration begins. 

 When configuration completes, the Database Control URL displays. Ma
because it is used to log in to the database. 

10. Click OK to close the Database Configuration Assistant. 
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Chapter 3 

Installing the Agile Database on Solaris 

This chapter includes the following: 

 Overview.............................................................................................................................................................. 17 
 Preparing the Host Computer .............................................................................................................................. 18 
 Creating the Agile Database................................................................................................................................ 21 
 Post-Installation Tasks......................................................................................................................................... 24 

Important  An Oracle database administrator should install this product. 
 
 

Overview 
This chapter provides information for installing Oracle and creating the Agile database on Solaris. 
Before you begin, make sure that you have reviewed all relevant Oracle documentation and 
ensured the computer meets the minimum system requirements.         

Important For best results, start with a clean system (no previous versions of Oracle). 

This chapter provides information for installing an Oracle database on Sun Solaris. The installation 
process consists of the following major steps: 

 Preparing an installation environment. 

 Installing Oracle 9i Release 2 or Oracle 10g Release 2. 

 Running the Agile database scripts to create the Agile database. 

 Configuring Oracle network connectivity and setting additional Oracle functionality. 
 

Oracle Source Documentation 

Before you begin, it is important to be familiar with all the information about installing the Oracle 
database on Solaris, and with the Optimal Flexible Architecture (OFA) reference material for 
administrators. See the following Oracle documents:   

 Oracle 9i Installation Guide Release 2 (9.2.0.1.0) for UNIX Systems: AIX-Based Systems, 
Compaq Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, and Sun Solaris. 

 Oracle 9i Administrator's Reference Release 2 (9.2.0.1.0) for UNIX Systems: AIX-Based 
Systems, Compaq Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, and Sun Solaris in 
Appendix G: “Optimal Flexible Architecture.” 

These documents are available on the Oracle Technology Network at  
http://otn.oracle.com/documentation/oracle9i.html 
(http://otn.oracle.com/documentation/oracle9i.html). 

HP- Oracle 10g Installation Guide Release 2 (10.2) for UNIX Systems: AIX-Based Systems, hp 
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UX PA-RISC (64-bit), hp Tru64 UNIX, Linux x86, and Solaris Operating System (SPARC) 

 Oracle Database Administrator’s Guide 10g Release 2 (10.2) 

These documents are available on the Oracle Technology Network at 
 http://www.oracle.com/technology/documentation/database10gR2.html 
(http://www.oracle.com/technology/documentation/database10gR2.html). 

Agile has made every Note attempt to be OFA-compliant. Any deviation from OFA 
guidelines are noted. 

 

System Requirements 

pecific system requirements, see the Capacity Planning and 

abase administrator are available 
to monitor system activity and determine resource requirements. 

Preparing the Host Computer 
stallation environment on Solaris, such as creating the 

sar

Note stallation, you should create an area containing the 

Before installing Oracle, ensure that your system configuration meets the minimum hardware 
requirements. If you are using a stand-alone system or hosting multiple instances, consider using 
the recommended hardware requirements for the specific environment to ensure acceptable 
performance. For information on s
Deployment Guide.                      

It is suggested that a Solaris system administrator and Oracle dat

This section describes how to prepare the in
neces y groups and user accounts.         

To avoid changing CDs during the in
Oracle installation files.     

To create the Oracle user account: 

1. Log in to the system as root. 
2.  the Oracle user: 

3. “oinstall” and “dba:” 

] 

4. 

/sh -g  
 dba oracle [Enter] 

irectory 

Create a home directory for

# mkdir -p /u01/oracle [Enter] 

Create two groups called 

# groupadd oinstall [Enter

# groupadd dba   [Enter] 

Create the Oracle user: 

# useradd -d /u01/oracle -s /bin
oinstall -G
where: 

/u01/oracle is the Oracle user home d

/bin/sh is the Oracle user login shell 

oinstall is the primary group for the Oracle user 

dba is the secondary group for the Oracle user 
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5. change the Oracle home file ownership: 

6. ctory: 

ase scripts. 

1. le user, and create a temporary directory named “agile9tmp:” 

2. n CD, and copy the agile9223b.tar.Z file from the installation CD to 

Note 

Set the Oracle user password, and 

# passwd oracle  [Enter] 

Enter password:
# chown oracle:dba /u01/oracle [Enter]   

Create the Oracle installation dire

# mkdir -p /u01/app/oracle [Enter]   

# chown oracle:oinstall /u01/app/oracle [Enter] 

You must now copy the Agile datab

To copy the Agile database utilities:   

Change to the Orac

# su - oracle [Enter] 

$ mkdir /u01/oracle/agile9tmp [Enter] 

Insert the Agile installatio
the agile9tmp directory: 

For Solaris, this file is named agile9223db_oracle9i.tar.z or 
agile9223db_oracle10g.tar.z. Choose the appropriate file as applicable for your 

sion.  Oracle ver

$ cd /cdrom [Enter]   

For Oracle 9i:$ cd /CD1_Agile/Solaris/DB/Oracle9i
For Oracle 10g:$ cd /CD1_Agile/Solaris/DB/Oracle10g

3. ry, and uncompress the files from the agile9222db.tar.Z file: 

r] 

4.    

ting the database maintenance script 

 dbora — setup for the database automatic shutdown and startup 
 dump file 

1.  file: 

$ cp agile9223db.tar.Z /u01/oracle/agile9tmp [Enter] 

Change to the agile9tmp directo

$ cd /u01/oracle/agile9tmp [Enter] 

$ uncompress agile9223db.tar.Z [Ente

Extract the agile9223db.tar file: 

$ tar -xvf agile9223db.tar [Enter]   

The agile9223db.tar file contains the following files: 
 agile9.sh — Bourne shell script for creating the database and schema 
 agile9db.sh — Bourne shell script for crea
 profile.txt — oracle user .profile template 
 system.txt — system kernel parameters 

 agile9schema.dmp — schema

To modify the system kernel parameters: 

Change to the root user, and back up the /etc/system

$ su -  [Enter] 
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# cp /etc/system /etc/system_save [Enter] 

2. eters. If the parameters do not exist, go to the next 

967295 

 

set n

Important If you have been running the host computer as an Oracle database server, you have to 
chec g these parameters. For 
these parameter settings, you can also refer to the Oracle documentation. 

Verify the following /etc/system kernel param
step.   

set shmsys:shminfo_shmmax=4294

set shmsys:shminfo_shmmin=1 

set shmsys:shminfo_shmmni=100 

set shmsys:shminfo_shmseg=10 

set semsys:seminfo_semmns=1024

set semsys:seminfo_semmni=100 

set semsys:seminfo_semmsl=500 

set semsys:seminfo_semopm=100 

set semsys:seminfo_semvmx=32767 

oexec_user_stack=1 (Note:On Oracle 10g only) 

k with your Solaris system administrator before changin

Note Restart the computer if you modify the /etc/system file. 

3. d system.txt file. Append system.txt to 
yste r. 

# cat /u01

d to recover the 

The previous kernel parameters are set in the distribute
/etc/s m if this is the first time you are configuring the host computer as the database serve

/oracle/agile9tmp/system.txt >> /etc/system 

Note Use >> to append. If you have accidentally used >, you nee
original /etc/system file by using cp system_save system. 

4. Restart th

stem, the database creation will fail. You may need 

e system to make the new kernel configuration take effect. 

Note If you do not restart the sy
to check with your Solaris system administrator for support. 

To set up Oracle environmental variables: 

1. 

2. ironmental parameter file .profile to include:  

E; export ORACLE_HOME 

ct/10.2.0/db_1; export ORACLE_HOME 

CLE_BASE 

 

Log in to the system as the Oracle user. 

Create the env

PATH=$PATH:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11 

export PATH  

(Oracle 9i)ORACLE_HOME=/u01/app/oracle/product/9.2.0S

(Oracle 10g)ORACLE_HOME=/u01/app/oracle/produ

ORACLE_BASE=/u01/app/oracle; export ORA

PATH=$PATH:$ORACLE_HOME/bin; export PATH

ORACLE_SID=agile9; export ORACLE_SID 
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TNS_ADMIN=/var/opt/oracle; export TNS_ADMIN 

NLS_LANG=American_America.UTF8; export NLS_LANG 

3. vious step are set in the distributed profile.txt file. If 
e host computer as a database server, copy the 

e.txt > .profile [Enter]   

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the 
 Oracle 9i

The environmental parameters in the pre
this is the first time you are configuring th
profile.txt file to .profile: 

$ cat agile9tmp/profil
4. Update the environmental setting: 

$ . ./.profile [Enter] 

Making the Oracle Installer Available 

computer. Use the instructions in Installing  (on page 57) or Installing Oracle 10g (on 
ion CDs. 

acle 9i

page 63) to copy the data from the installat

Installing the Oracle Database 

Use the instructions in Installing Or  (on page 57) or Installing Oracle 10g (on page 63) to 
ot already installed. 

On Solaris, Agile officially supports the native Solaris file system. To enable the vxfs file system for 
 script: 

' 

: 
ine;print $4/1024}'' 

w to create the default database instance and schema used by Agile using 

To st

1. Log r as the Oracle user. 

1. e .profile file to change Oracle SID. By default, Agile uses agile9 as the 

rofile [Enter]   

Impo Che s not 
bee pt that database instance. 

install the Oracle database, if it is n

vxfs File System Support 

testing, remove the bold text as shown in the agile9.sh
space='df -kFufs $dir | nawk '{getline;print $4/1024}'

After modification, the line should appear as follows
space='df -k $dir | nawk '{getl

Creating the Agile Database 
This section describes ho
the Agile database creation utility.       

art the installation:     

 in to the compute

If necessary, edit th
Oracle SID:        

$ vi .p
2. Modify the value where ORACLE_SID=agile9 by replacing agile9 with the SID you want to 

use. 

rtant ck the /var/opt/oracle/oratab file and make sure that the specified Oracle SID ha
n used. Specifying an existing Oracle SID can corru
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Note  four alphanumeric characters. This avoids lengthy  Generally, the SID length is
database filenames for associated database files. 

3. Run .profile to make the SID changes take effect: 

./ch
2. In a seco

3. Create a 

$. mod u+x .profile    [Enter]    

nd terminal session, log in to the computer as the root user. 

directory named “oradata.” 

Note The agile9.sh file uses a dummy mount point /mpt. You must change /mpt to 
match your mount points. For OFA compliance, it is highly recommended that 
you create at least four m
multiple controll

ount points (preferably on four different disks across 
ers) to optimize disk I/O. 

For ints at /u01 and /u02, you can create an oradata folder on 

r -p /u01/oradata

d in as the Oracle user, create a $ORACLE_BASE/admin 

You

5. 

6. s on your computer, and then copy the 

Note 

example, if you have mount po
each mount point. 

# mkdi
# chown oracle:dba /u01/oradata

4. In the session where you are logge
directory: 

$ mkdir -p /u01/app/oracle/admin [Enter] 

 must now run the agile9.sh script. 

Change to the /u01/oracle/agile9tmp directory. 

script to match the mount pointModify the agile9.sh 
script to the Oracle user home directory (/u01/oracle). 

Make sure ORACLE_SID matches the one you set for .profile, which should 
have taken effect after you ran . ./.profile. 

Note The agile9.sh file uses a dummy mount point /mpt. You must change /mpt to 
match your mount points. For OFA compliance, it is highly recommended that 
you create at least four mount points (preferably on four different disks across 
multiple controllers) to optimize disk I/O. 

The ur editing only 
to th

For oint created at /u01, you can modify agile9.sh and quickly 
ate 

$ cat  | sed -e "s/mpt\//u01\//g" > /u01/oracle/agile9.sh
od u+x /u01/oracle/agile9.sh

te The following code list variable in bold that you may want to revise besides 

 values in the script that can be modified appear in bold. You should limit yo
ese bold values. 

example, if you have a mount p
recre it in the Oracle user home directory by issuing one command. 

/u01/oracle/agile9tmp/agile9.sh
$ chm

No
dummy mount point /mpt 

#!/bin/sh 

# 

# Oracle_sid default as agile9 
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# 

ORACLE_SID=agile9     # Oracle SID for the database 

AASYSPW=oracle       # Oracle sys passwd for the database 

SYSTEMPW=manager   # Oracle system passwd for the database 

hema 

e passwd for AGILE 

e

P tablespace

RS tablespace

X tablespace

TABASE_CONTROL2=/mpt/oradata/${ORACLE_SID}   # CONTROL file 2

ORACLE_SID}   # CONTROL file 3

TABASE_ARCHIVE=/mpt/oradata/${ORACLE_SID}/arch  #ARCHIVELOGS

t used 

_SET=UTF8

AA

AGILE=agile      # Oracle account for AGILE sc

AGILEPW=tartan   # Oracl

# 

# Parameters determine location of datafiles,  
# controlfiles and logfiles 

# 
DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID} # SYSTEM tablespac

DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID}  # TOOLS tablespace

DATABASE_UNDO=/mpt/oradata/${ORACLE_SID}   # RBS tablespace

DATABASE_TEMP=/mpt/oradata/${ORACLE_SID}   # TEM

DATABASE_USERS=/mpt/oradata/${ORACLE_SID}  # USE

DATABASE_INDX=/mpt/oradata/${ORACLE_SID}   # IND

DATABASE_AGILE_DATA1=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX1=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX2=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA4=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX4=/mpt/oradata/${ORACLE_SID}

DATABASE_LOGFILES1=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 1

DATABASE_LOGFILES2=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 2

DATABASE_LOGFILES3=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 3

DATABASE_LOGFILES4=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 4

DATABASE_CONTROL1=/mpt/oradata/${ORACLE_SID}   # CONTROL file 1

DA

DATABASE_CONTROL3=/mpt/oradata/${

DA

#

# Parameters determine character se

# 
CHARACTER

NATIONAL_CHARACTER_SET=UTF8
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7. cript from the Oracle user home directory: 

$ cp agile9

Run the agile9.sh s

$ cd [Enter] 

tmp/agile9schema.dmp . [Enter] 

$ ./agile9.sh [Enter] 

Note If you are unable to create files, you may have to give the system user full 
privileges to the u01 directory. 

8. atabase size that you want to install. 

requi

r passwords after you have created the Agile database. It 
e passwords periodically for security purposes. 

9. Continue to the next section for post-installation tasks. 

Post-Installation Tasks 
This section describes how to configure Oracle Net Manager, and set the automatic startup and 

abase. 

If yo ble to specify the location of Oracle Network Services 
con ve the files located in the 

1.  and change the ownership of the /var/opt/oracle directory: 

 [Enter] 

2. CLE_HOME/network/admin network 

r]   

/admin [Enter] 

IN, which is 

You are prompted about the d

You should use the regular database size unless you have consulted with an Agile Solutions 
Consultant or database administrator to ensure that the computer meets the minimum 

rements for the specified database size. 

The script will run for awhile. 

Important Change all Oracle database use
is recommended to change thes

 

shutdown features for the dat

Setting Up Oracle Net Manager 

To set up Oracle t Manager:  Ne

u use the TNS_ADMIN environment varia
figuration files (such as tnsnames.ora), mo

$ORACLE_HOME/network/admin directory to the directory specified by TNS_ADMIN. 

Log in as root
# chown -R oracle:dba /var/opt/oracle
Switch to the Oracle user, and change to the $ORA
directory: 

# su - oracle [Ente

$ cd $ORACLE_HOME/network
3. Move all the files to the directory defined by environmental parameter TNS_ADM

/var/opt/oracle: 

$ mv * /var/opt/oracle [Enter] 
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Se ting Up Automatict  Shutdown and Startup for the Database 

To s  and start up when the host computer starts up and 
s down: 

.d/K10dbora  [Enter]   

nit.d/dbora /etc/rc2.d/S99dbora  [Enter]   
 

If you ar pg  database on the same machine, you only need to add the new 
database  t

To config  t ra file:         

1. 

2. Within th

1. e  the following settings appear in one of the Address tabs: 

r where the Oracle database is installed 

s tab appears. 

3. p

 installed 

ervice in the Listener Location drop-down list. 

6. In the dialog box that appears, make the following changes: 

le Home Directory: Oracle_Home 
SID:  

 Sav nges. 

4. 

Configuring the tnsnames.ora File (Optional) 

et up the Oracle database to automatically shut down
shut

1. Log in the system as root. 
2. Create a file named “dbora” in the /etc/init.d directory:  

# cat /u01/oracle/agile9tmp/dbora > /etc/init.d/dbora [Enter] 

3. Link to the dbora file:    

# ln -s /etc/init.d/dbora /etc/rc0
# ln -s /etc/i

Configuring the listener.ora File 

e u rading your Agile
 to he existing listener. 

ure he listener.o

Start Net Manager: 

$ netmgr &
e Local folder, open the Listeners folder and select LISTENER. 

Ch ck to see if
 Protocol: TCP/IP 
 Host: the host compute
 Port: 1521 

2. If the information does not appear, click Add Address. A new Addres
Ty e these settings: 

P/IP  Protocol: TC
 Host: the host computer where the Oracle database is
 Port: 1521 

4. Select Database S
5. Click Add Database. 

 Global Database Name: agile9 
 Orac
 

3. Choose 
 agile9

File > e Network Configuration to save your cha

Close Net Manager. 
 

1. In the Oracle Net Manager window, double-click the Local folder and select the Service Naming 
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folder.         

2. Click Create  in the toolbar to add a service name. 

where the Oracle database is 

ocol) and click Next. 
e name 

step 3). Accept 1521 as the default port number. Click Next. 
e agile9 in the field. Click Next. 

 

8. Click Change Login to reset the username and password.     

9. Type agile in the Username field and tartan in the Password field. Click OK. 

10. Click Test. You should now see a message indicating that the test was successful.    

11. Click Close. 

12. Click Finish to exit the Net Service Name Wizard. 

13. From the Net Manager menu, choose File > Save Network Configuration to save the service name. 

This completes the installation and configuration for Oracle on Solaris. 

The Net Service Name Wizard starts.    

3. In the Net Service Name field, type the name of the computer 
located (usually the current computer). Click Next.      

4. You are prompted to select a network protocol. Select TCP/IP (Internet Prot
5. Type the name of the computer where Oracle is located in the Hostname field (the sam

you typed in 

6. Select Oracle8i or later as the service name, and typ

7. Click Test to test the service. 

The test initially fails because the default uses the incorrect login.   
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Chapter 4 

Installing the Agile Database on Linux 

This chapter includes the following: 

 Overview.............................................................................................................................................................. 27 
 Preparing the Host Computer .............................................................................................................................. 28 
 Creating the Agile Database................................................................................................................................ 30 
 Post-Installation Tasks......................................................................................................................................... 33 

Important An Oracle database administrator should install this product. 

 
 

Overview 
This chapter provides information for installing Oracle and creating the Agile database on Linux. 
Before you begin, make sure that you have reviewed all relevant Oracle documentation and 
ensured the computer meets the minimum system requirements.         

Important For best results, start with a clean system (no previous versions of Oracle). 

This chapter provides information for installing an Oracle database on RedHat Enterprise Linux 4. 
The installation process consists of the following major steps: 

 Preparing an installation environment. 

 Installing Oracle 10g Release 2. 

 Running the Agile database scripts to create the Agile database. 

 Configuring Oracle network connectivity and setting additional Oracle functionality. 
 

Oracle Source Documentation 

Before you begin, it is important to be familiar with all the information about installing the Oracle 
database on Linux, and with the Optimal Flexible Architecture (OFA) reference material for 
administrators. See the following Oracle documents:   

 Oracle 10g Installation Guide Release 2 (10.2) for UNIX Systems: AIX-Based Systems, hp HP-
UX PA-RISC (64-bit), hp Tru64 UNIX, Linux x86, and Solaris Operating System (SPARC) 

 Oracle Database Administrator’s Guide 10g Release 2 (10.2) 

These documents are available on the Oracle Technology Network at 
 http://www.oracle.com/technology/documentation/database10gR2.html 
(http://www.oracle.com/technology/documentation/database10gR2.html). 

Note Agile has made every attempt to be OFA-compliant. Any deviation from OFA 
guidelines are noted. 
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System Requirements 

Before installing Oracle, ensure that your system configuration meets the minimum hardware 
requirements. If you are using a stand-alone system or hosting multiple instances, consider using 
the recommended hardware requirements for the specific environment to ensure acceptable 
performance. For information on specific system requirements, see the Capacity Planning Guide.                      

It is suggested that a system administrator and Oracle database administrator are available to 
monitor system activity and determine resource requirements. 

Preparing the Host Computer 
This section describes how to prepare the installation environment on Linux, such as creating the 
necessary groups and user accounts.         

Note To avoid changing CDs during the installation, you should create an area containing the 
Oracle installation files.     

To create the Oracle user account: 

1. Log in to the system as root. 
2. Create a home directory for the Oracle user: 

# mkdir -p /u01/oracle [Enter] 

3. Create two groups called “oinstall” and “dba:” 

# groupadd oinstall [Enter] 

# groupadd dba   [Enter] 

4. Create the Oracle user: 

# useradd -d /u01/oracle -s /bin/sh -g  
oinstall -G dba oracle [Enter] 

where: 

/u01/oracle is the Oracle user home directory 

/bin/sh is the Oracle user login shell 

oinstall is the primary group for the Oracle user 

dba is the secondary group for the Oracle user 

5. Set the Oracle user password, and change the Oracle home file ownership: 

# passwd oracle  [Enter] 

Enter password:
# chown oracle:dba /u01/oracle [Enter]   

6. Create the Oracle installation directory: 

# mkdir -p /u01/app/oracle [Enter]   

# chown oracle:oinstall /u01/app/oracle [Enter] 
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You must now copy the Agile database scripts. 

To copy the Agile database utilities:   

1. Change to the Oracle user, and create a temporary directory named “agile9tmp:” 

# su - oracle [Enter] 

$ mkdir /u01/oracle/agile9tmp [Enter] 

2. Insert the Agile installation CD, and copy the agile9223db.tar.gz file from the installation CD to 
the agile9tmp directory: 

Note For Linux, this file is named agile9223db_oracle10g.tar as only Oracle 10g is 
supported. 

$ cd /cdrom [Enter]   

$ cd /CD1_Agile/Linux/DB/Oracle10g
$ cp agile9223db.tar.gz /u01/oracle/agile9tmp [Enter] 

3. Change to the agile9tmp directory, and uncompress the files from the agile9223db.tar.gz file: 

$ cd /u01/oracle/agile9tmp [Enter] 

$ gunzip agile9223db.tar.gz [Enter] 

4. Extract the agile9223db.tar file:    

$ tar -xvf agile9223db.tar [Enter]   

The agile9223db.tar file contains the following files: 
 agile9.sh — Bourne shell script for creating the database and schema 
 agile9db.sh — Bourne shell script for creating the database maintenance script 
 profile.txt — oracle user .profile template 
 dbora — setup for the database automatic shutdown and startup 

 readme.txt — the readme file 
 agile9schema.dmp — schema dump file 

To set up Oracle environmental variables: 

1. Log in to the system as the Oracle user. 

2. Create the environmental parameter file .profile to include:  

al/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11 PATH=$PATH:/usr/loc

export PATH  

RACLE_HOME ORACLE_HOME=/u01/app/oracle/product/10.2.0/db_1; export O

ORACLE_BASE=/u01/app/oracle; export ORACLE_BASE 

 PATH=$PATH:$ORACLE_HOME/bin; export PATH

ORACLE_SID=agile9; export ORACLE_SID 

TNS_ADMIN=/var/opt/oracle; export TNS_ADMIN 

NG=American_America.UTF8; export NLS_LANG NLS_LA
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Note Make sure the ORACLE_HOME and ORACLE_BASE entries contain the 
correct directory paths. 

3. The environmental parameters in the previous step are set in the distributed profile.txt file. If 
this is the first time you are configuring the host computer as a database server, copy the 
profile.txt file to .profile: 

$ cat agile9tmp/profile.txt > .profile [Enter]   

4.  Update the environmental setting: 

$ . ./chmod u+x .profile [Enter] 

Making the Oracle Installer Available 

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the 
computer.   Use the instructions in Installing Oracle 10g (on page 63) to copy the data from the 
installation CDs. 

Installing the Oracle Database 

Use the instructions in Installing Oracle 10g (on page 63) to install the Oracle database, if it is not 
already installed. 

Creating the Agile Database 
This section describes how to create the default database instance and schema used by Agile using 
the Agile database creation utility.       

To start the installation:     

1. Log in to the computer as the Oracle user. 

 

2. If necessary, edit the .profile file to change Oracle SID. By default, Agile uses agile9 as the 
Oracle SID:        

$ vi .profile [Enter]   

3. Modify the value where ORACLE_SID=agile9 by replacing agile9 with the SID you want to use. 

Important Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID has not 
been used. Specifying an existing Oracle SID can corrupt that database instance. 

Note Generally, the SID length is four alphanumeric characters. This avoids lengthy 
database filenames for associated database files. 

4. Run .profile to make the SID changes take effect: 

$ . ./chmod u+x .profile    [Enter]    

5. In a second terminal session, log in to the computer as the root user. 

6. Create a directory named “oradata.” 
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Note The agile9.sh file uses a dummy mount point /mpt. You must change /mpt to 
match your mount points. For OFA compliance, it is highly recommended that 
you create at least four mount points (preferably on four different disks across 
multiple controllers) to optimize disk I/O. 

For example, if you have mount points at /u01 and /u02, you can create an oradata folder on 
each mount point. 

# mkdir -p /u01/oradata
# chown oracle:dba /u01/oradata

7. In the session where you are logged in as the Oracle user, create a $ORACLE_BASE/admin 
directory: 

$ mkdir -p /u01/app/oracle/admin [Enter] 

You must now run the agile9.sh script. 

8. Change to the /u01/oracle/agile9tmp directory. 

9. Modify the agile9.sh script to match the mount points on your computer, and then copy the 
script to the Oracle user home directory (/u01/oracle). 

Important Make sure ORACLE_SID matches the one you set for .profile, which should have taken 
effect after you ran . ./.profile. 

Note The agile9.sh file uses a dummy mount point /mpt. You must change /mpt to 
match your mount points. For OFA compliance, it is highly recommended that 
you create at least four mount points (preferably on four different disks across 
multiple controllers) to optimize disk I/O. 

The values in the script that can be modified appear in bold. You should limit your editing only 
to these bold values. 

For example, if you have a mount point created at /u01, you can modify agile9.sh and quickly 
recreate it in the Oracle user home directory by issuing one command.        

$ cat /u01/oracle/agile9tmp/agile9.sh | sed -e "s/mpt\//u01\//g" > /u01/oracle/agile9.sh
$ chmod u+x /u01/oracle/agile9.sh

Note The following code lists variable in bold that you may want to revise besides 
dummy mount point /mpt 

 

#!/bin/sh 

# 

# Oracle_sid default as agile9 

# 

ORACLE_SID=agile9     # Oracle SID for the database 

AASYSPW=oracle       # Oracle sys passwd for the database 

AASYSTEMPW=manager   # Oracle system passwd for the database 

AGILE=agile      # Oracle account for AGILE schema 

AGILEPW=tartan   # Oracle passwd for AGILE 
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# 

# Parameters determine location of datafiles,  
# controlfiles and logfiles 

# 
DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID} # SYSTEM tablespace

DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID}  # TOOLS tablespace

DATABASE_UNDO=/mpt/oradata/${ORACLE_SID}   # RBS tablespace

DATABASE_TEMP=/mpt/oradata/${ORACLE_SID}   # TEMP tablespace

DATABASE_USERS=/mpt/oradata/${ORACLE_SID}  # USERS tablespace

DATABASE_INDX=/mpt/oradata/${ORACLE_SID}   # INDX tablespace

DATABASE_AGILE_DATA1=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX1=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX2=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA4=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX4=/mpt/oradata/${ORACLE_SID}

DATABASE_LOGFILES1=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 1

DATABASE_LOGFILES2=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 2

DATABASE_LOGFILES3=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 3

DATABASE_LOGFILES4=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 4

DATABASE_CONTROL1=/mpt/oradata/${ORACLE_SID}   # CONTROL file 1

DATABASE_CONTROL2=/mpt/oradata/${ORACLE_SID}   # CONTROL file 2

DATABASE_CONTROL3=/mpt/oradata/${ORACLE_SID}   # CONTROL file 3

DATABASE_ARCHIVE=/mpt/oradata/${ORACLE_SID}/arch  #ARCHIVELOGS

#

# Parameters determine character set used 
#

CHARACTER_SET=UTF8

NATIONAL_CHARACTER_SET=UTF8

10. Run the agile9.sh script from the Oracle user home directory: 

$ cd [Enter] 

$ cp agile9tmp/agile9schema.dmp . [Enter] 

$ ./agile9.sh [Enter] 
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Note If you are unable to create files, you may have to give the system user full 
privileges to the u01 directory. 

11. You are prompted about the database size that you want to install. 

You should use the regular database size unless you have consulted with an Agile Solutions 
Consultant or database administrator to ensure that the computer meets the minimum 
requirements for the specified database size. 

The script will run for awhile. 

Important Change all Oracle database user passwords after you have created the Agile database. It 
is recommended to change these passwords periodically for security purposes. 

Continue to the next section for post-installation tasks. 

Post-Installation Tasks 
This section describes how to configure Oracle Net Manager, and set the automatic startup and 
shutdown features for the database. 

Setting Up Oracle Net Manager 

To set up Oracle Net Manager: 

If you use the TNS_ADMIN environment variable to specify the location of Oracle Network Services 
configuration files (such as tnsnames.ora), move the files located in the 
$ORACLE_HOME/network/admin directory to the directory specified by TNS_ADMIN. 

1. Log in as root and change the ownership of the /var/opt/oracle directory: 

# chown -R oracle:dba /var/opt/oracle [Enter] 

2.  Switch to the Oracle user, and change to the $ORACLE_HOME/network/admin network 
directory: 

# su - oracle [Enter]   

$ cd $ORACLE_HOME/network/admin [Enter] 

3. Move all the files to the directory defined by environmental parameter TNS_ADMIN, which is 
/var/opt/oracle: 

$ mv * /var/opt/oracle [Enter] 

Setting Up Automatic Shutdown and Startup for the Database 

To set up the Oracle database to automatically shut down and start up when the host computer starts up and 
shuts down: 

1. Log in the system as root. 
2. Create a file named “dbora” in the /etc/init.d directory:  

# cat /u01/oracle/agile9tmp/dbora > /etc/init.d/dbora [Enter] 

3. Link to the dbora file:    
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# ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora  [Enter]   

# ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora  [Enter]   
 

Configuring the listener.ora File 

To configure the listener.ora file:         

1. Start Net Manager: 

$ netmgr &
2. Within the Local folder, open the Listeners folder and select LISTENER. 

1. Check to see if the following settings appear in one of the Address tabs: 
 Protocol: TCP/IP 
 Host: the host computer where the Oracle database is installed 
 Port: 1521 

2. If the information does not appear, click Add Address. A new Address tab appears. 

3. Type these settings: 
 Protocol: TCP/IP 
 Host: the host computer where the Oracle database is installed 
 Port: 1521 

4. Select Database Service in the Listener Location drop-down list. 

5. Click Add Database. 

6. In the dialog box that appears, make the following changes: 
 Global Database Name: agile9 
 Oracle Home Directory: Oracle_Home 
 SID: agile9 

3. Choose File > Save Network Configuration to save your changes. 

4. Close Net Manager. 
 

Configuring the tnsnames.ora File (Optional) 
1. In the Oracle Net Manager window, double-click the Local folder and select the Service Naming 

folder.         

2. Click Create  in the toolbar to add a service name. 

The Net Service Name Wizard starts.    

3. In the Net Service Name field, type the name of the computer where the Oracle database is 
located (usually the current computer). Click Next.      

4. You are prompted to select a network protocol. Select TCP/IP (Internet Protocol) and click Next. 
5. Type the name of the computer where Oracle is located in the Hostname field (the same name 

you typed in step 3). Accept 1521 as the default port number. Click Next. 
6. Select Oracle8i or later as the service name, and type agile9 in the field. Click Next. 
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7. Click Test to test the service. 

The test initially fails because the default uses the incorrect login.    

8. Click Change Login to reset the username and password.     

9. Type agile in the Username field and tartan in the Password field. Click OK. 

10. Click Test. 
You should now see a message indicating that the test was successful.    

11. Click Close. 

12. Click Finish to exit the Net Service Name Wizard. 

13. From the Net Manager menu, choose File > Save Network Configuration to save the service name. 

This completes the installation and configuration for Oracle on Linux. 
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Installing the Product Interchange Database 
on Windows 

This chapter includes the following: 

 Installation Notes ................................................................................................................................................. 37 
 Copying the Agile CDs......................................................................................................................................... 37 
 Installing the Oracle Database............................................................................................................................. 37 
 Starting the Installer............................................................................................................................................. 38 
 Agile PLM Components ....................................................................................................................................... 39 
 Using the Product Interchange Database Customization Utility .......................................................................... 39 
 Adding and Configuring the Listener ................................................................................................................... 40 
 Configuring Oracle Database Control (Optional) ................................................................................................. 41 

Note Unless specified otherwise, all references to Windows specifically require Windows 2003 
with Service Pack 2. Service Packs are available on Microsoft’s Web site, 
www.microsoft.com.        

 

Installation Notes 
For best results, as you install: 

 Follow directions in the order in which they are given. Do not attempt to install any components 
out of sequence.    

 Oracle passwords are not case-sensitive. Agile passwords are case-sensitive. All other text 
entries, such as schema names and folder names, are not case-sensitive. To avoid confusion, 
all passwords and text entries in this guide appear in lowercase and should be typed as shown. 

 When prompted for a hostname, type the short name for the host, not the fully qualified name. 
For example, if a host is named dbo, type dbo, not dbo.agile.com. 

 

Copying the Agile CDs 
Before installing Agile PLM, the contents of both CDs should be copied to a local directory with the 
same file structure as the original CDs. The Platform directory on CD #2 must be copied on the 
same directory level as the setup.exe file. 

Installing the Oracle Database 
The Product Interchange database is supported on Oracle 9i Release 2 and Oracle 10g Release 2. 
Use the instructions in Installing Oracle 9i (on page 57) to install Oracle 9i Release 2 or Installing 
Oracle 10g (on page 63) to install Oracle 10g Release 2. 
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Starting the Installer 
The installation of all components follows the same initial process up through the panel where you 
select the components to install.      

Important To run the Agile installation program, you must have at least 1200MB of available disk 
space on Windows on the drive where your default Temp directory is located. 

Note Disable virus protection, if you are using it. Components used in the installer can be 
falsely identified as being infected and lock up the installation. You can turn the virus 
protection on after the installation is complete. 

To start the Agile PLM installer on Windows: 

1. Log in to the computer using a login with local Administrator permissions. 

2. In the Agile installation directory for Windows, double-click the setup.exe file. 

Note If there is insufficient disk space available to complete the installation, you will 
be prompted for another location. Click Choose, select another drive, Click OK, 
and the installer will start. 

After a few moments, the Welcome screen appears. 

Installer Buttons 

Agile PLM installation panels have the following buttons: 

 Cancel — Exits from the installation program. 

 Help — Displays online help. 

 Previous — Returns to the previous step. 

 Next — Proceeds to the next step. 

 Install — Starts installing. The Install button appears only on the Pre-Installation Summary 
cified installation options. panel, after you have spe

 Done — Exits from the installation program. On Windows, after installing certain components 
you can choose whether to restart the computer when you click Done. The Done button appears 
only on the Install Complete panel, after you have finished installing. 

 

Installer Online Help 

Each installation panel has online help. At any time during installation, you can click Help for more 
information about the panel’s options. 

If you leave the online help window open, it will be updated when you proceed through the installer 
panels. Otherwise, click Close at the bottom of the help window. 
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Agile PLM Components 
During Agile PLM installation, you must select components to install. The list of components you 
can install is based on your license key. Choose Database Server and Product Interchange when this list 
displays to install and create the Product Interchange database schema. 

Using the Product Interchange Database Customization 
Utility 
You can now use the Product Interchange database configuration utility to create and configure the 
database.         

Note The installer creates and configures an Agile Product Interchange database using the 
default values. 

All hard drive indicators show the available disk space. If the space is a negative value, you must 
select another hard drive. 

Important If you change a default value, you must click in the field to ensure that the change is 
activated. 

To customize the Product Interchange Database: 

1. In the Agile PLM installer, click Install. The database customization utility appears.  

2. In the Destination Location dialog box, accept the default location. This is the location where 
files are placed during the database installation. Click Next.  

3. In the Database Size Estimate dialog box, if you are a new Agile customer without an existing 
database to migrate, accept the default (Small). Click Next.  

4. In the Oracle Home dialog box, accept the default unless there is insufficient disk space 
available. This is the location where the Oracle database files were installed.  Click Next.  

5. In the Oracle SID dialog box, accept the default pidb SID. If you want to change the SID, you 
must use a 4-character ID to uniquely identify the Oracle SID. If you want to use an existing 
SID, you must remove it before you can re-use it. Click Next.  

6. In the Database Security and Agile User Information dialog box, accept the default values or 
change to the values specific to your system:  
 Internal/Sys Password is oracle 
 System Password is manager 
 Product Interchange Schema Password is piuser 
 Dralasoft Workflow User Password is dwe 

Click Next.  
7. In the Tablespaces, Redo Log Files, and Control Files dialog boxes, accept the default, unless 

you have additional hard drives with sufficient space available that allow you to distribute the 
files across multiple hard drives. Click Next. 

8.  If you accept the default location for the files on one drive, a message appears notifying you 
about distributing the files across multiple drives (mirroring protection). If this is not an option, 
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click Next. Otherwise, click Back and reassign files to different hard drives. 

9. In the Archive Log File dialog box, accept the default, unless you have additional hard drives 
with sufficient space available that allow you to store the file on a different hard drive. Click 
Next. 

10. In the Oracle Language Support dialog box, choose the default character set UTF8. Click Next  
For additional information about language support, refer to the Oracle Globalization Support 
Guide. 

11. A Command Prompt window displays briefly. You are prompted to install the Product 
Interchange database. Click Next. 
The script runs in a Command Prompt window for a while. The window automatically closes 
when the database is installed. 

Adding and Configuring the Listener 
If this is the first time Oracle has been installed on the current computer, you need to add and 
configure a new address to the Listener settings. 

To add a new Listener address on Oracle 9i:         

1. Start the Oracle Net Configuration Assistant by choosing Start > All Programs > Oracle -OraHome92 
> Configuration and Migration Tools > Net Configuration Assistant. 

2. In the Oracle Net Configuration Assistant window, select Listener Configuration. Click Next. 
3. Select Add to add a listener to the database. Click Next. 
4. Accept the default listener name, LISTENER, in the Listener Name dialog box. Click Next. 
5. Accept TCP as the Selected Protocol. Click Next. 
6. Accept the standard port of 1521. Click Next. 
7. Select No when asked to configure another listener. Click Next. 
8. The Listener configuration is complete. Click Next. 
9. Click Finish to close the Oracle Net Configuration Assistant window. 

To configure the new Listener address on Oracle 9i: 

1. Start the Oracle Net Manager by choosing Start > All Programs > Oracle  
- OraHome92 > Configuration and Migration Tools > Net Manager. 

2. In the Oracle Net Manager window, double-click the Local folder and select the Listeners folder. 

3. Click the name of the newly created listener, LISTENER. 

4. Select Database Services in the Listening Locations drop-down list. 

1. Click Add Database. 

2. In the dialog box that appears, make the following changes: 
 Global Database Name: pidb 
 Oracle Home Directory: d:\oracle\ora92 
 SID: pidb 
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Note If you used a different global database name or different home directory during 
the database installation, change the information as appropriate. 

5. Choose File > Save Network Configuration to save your changes. 

To add and configure a new Listener address on Oracle 10g:         

1. Start the Oracle Net Manager by choosing Start > All Programs > Oracle  
- OraDb10g_home1 > Configuration and Migration Tools > Net Manager. 

2. In the Oracle Net Manager window, double-click the Local folder and select the Listeners folder. 

3. Click Create  in the toolbar to add a listener. The Choose Listener Name dialog box 
appears. 

4. Click OK. 

5. Select Database Services in the Listening Locations drop-down list. 

1. Click Add Database. 

2. In the dialog box that appears, make the following changes: 
 Global Database Name: pidb 
 Oracle Home Directory: oracle_home 
 SID: pidb 

Note If you used a different global database name or different home directory during 
the database installation, change the information as appropriate. 

6.  Choose File > Save Network Configuration to save your changes. 

7.  Open a Command Prompt window and type lsnrctl reload to restart the database listener. 
 

Configuring Oracle Database Control (Optional) 
In Oracle 10g, you can use Database Control to perform many database administration and 
management tasks including SQL performance tuning. 

To configure Oracle database control: 

1. Choose Start > All Programs > Oracle - OraDb10g-home1 > Configuration and Migration Tools > 
Database Configuration Assistant. 
The Welcome screen appears. 

2. Click Next. 
3. Choose Configure Database Options on the Operations page. Click Next. 

The Database page appears 

4. Select the pidb database you just created. Click Next. 
The Management Options page appears. 

5. Check Configure the Database with Enterprise Manager. Click Next. 
The Database Content page appears. 

6. Accept the defaults. Click Next. 
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The Database Credentials page appears. 

7. Enter a password for the DBSNMP and SYSMAN users. Click Next. 
The Connection Mode page appears. 

8. Select Dedicated Server Mode. Click Next. 
9. Click OK for confirmation. Database configuration begins. 

 When configuration completes, the Database Control URL displays. Make a note of this URL 
because it is used to log in to the database. 

10. Click Finish to close the Database Configuration Assistant. 

11. Open a web browser and enter the Database Control URL. 

12. Type the User Name and Password of the Product Interchange database. Click Login. 

13. Click I agree to accept the license agreement and display the Database Control page. 

You have finished installing and configuring the Product Interchange database. 
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Chapter 6 

Installing the Product Interchange Database 
on Solaris 

This chapter includes the following: 

 Overview.............................................................................................................................................................. 43 
 Preparing the Host Computer .............................................................................................................................. 44 
 Creating the Product Interchange Database ....................................................................................................... 47 
 Post-Installation Tasks......................................................................................................................................... 50 

Important  An Oracle database administrator should install this product. 
 
 

Overview 
This chapter provides information for installing Oracle and creating the Product Interchange 
database on Solaris. Before you begin, make sure that you have reviewed all relevant Oracle 
documentation and ensured the computer meets the minimum system requirements.         

Important  For best results, start with a clean system (no previous versions of Oracle). 

This chapter provides information for installing an Oracle database on Sun Solaris. The installation 
process consists of four major steps: 

  Preparing an installation environment. 

  Installing Oracle 9i Release 2 or Oracle 10g Release 2. 

  Running the Product Interchange database scripts to create the database. 

  Configuring Oracle network connectivity and setting additional Oracle functionality. 
 

Oracle Source Documentation 

Before you begin, it is important to be familiar with all the information about installing the Oracle 
database on Solaris, and with the Optimal Flexible Architecture (OFA) reference material for 
administrators. See the following Oracle documents:   

 Oracle 9i Installation Guide Release 2 (9.2.0.1.0) for UNIX Systems: AIX-Based Systems, 
Compaq Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, and Sun Solaris. 

 Oracle 9i Administrator's Reference Release 2 (9.2.0.1.0) for UNIX Systems: AIX-Based 
Systems, Compaq Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, and Sun Solaris in 
Appendix G: “Optimal Flexible Architecture.” 

These documents are available on the Oracle Technology Network at  
http://otn.oracle.com/documentation/oracle9i.html 
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(http://otn.oracle.com/documentation/oracle9i.html). 

 HP-
perating System (SPARC) 

 

Oracle 10g Installation Guide Release 2 (10.2) for UNIX Systems: AIX-Based Systems, hp 
UX PA-RISC (64-bit), hp Tru64 UNIX, Linux x86, and Solaris O

Oracle Database Administrator’s Guide 10g Release 2 (10.2) 

These documents are available on the Oracle Technology Network at 
 http://www.oracle.com/technology/documentation/database10gR2.html 
(http://www.oracle.com/technology/documentation/database10gR2.html). 

Agile has made every Note attempt to be OFA-compliant. Any deviation from OFA 
guidelines are noted. 

 

System Requirements 

e.

ion of Agile manuals on the Agile Documentation Web site 

abase administrator are available 
to monitor system activity and determine resource requirements. 

Preparing the Host Computer 
stallation environment on Solaris, such as creating the 

sar

Note stallation, you should create an area containing the 

Before installing Oracle, ensure that your system configuration meets the minimum hardware 
requirements. If you are using a stand-alone system or hosting multiple instances, consider using 
the recommended hardware requirements for the specific environment to ensure acceptable 
performance. For information on specific system requirements, see the Capacity Planning Guid

Note You can access the latest vers
(http://docs.agile.com).                  

It is suggested that a Solaris system administrator and Oracle dat

This section describes how to prepare the in
neces y groups and user accounts.         

To avoid changing CDs during the in
Oracle installation files.     

To create the Oracle user account: 

1. Log in to the system as root. 
2.  the Oracle user: 

3. “oinstall” and “dba:” 

] 

4. 

/sh -g  
 dba oracle [Enter] 

irectory 

Create a home directory for

# mkdir -p /u01/oracle [Enter] 

Create two groups called 

# groupadd oinstall [Enter

# groupadd dba   [Enter] 

Create the Oracle user: 

# useradd -d /u01/oracle -s /bin
oinstall -G
where: 

/u01/oracle is the Oracle user home d
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/bin/sh is the Oracle user login shell 

oinstall is the primary group for the Oracle user 

dba is the secondary group for the Oracle user 

5. change the Oracle home file ownership: 

6. ctory: 

ter] 

1. le user, and create a temporary directory named “agilepitmp:” 

2. n CD, and copy the pidb.tar.Z file from the installation CD to 
ory: 

racle10g

3. ry, and uncompress the files from the pidb.tar.Z file: 

] 

er] 

4.  

se and schema 

utdown and startup 
 dump file 

1. ck up the /etc/system file: 

Set the Oracle user password, and 

# passwd oracle  [Enter] 

Enter password:
# chown oracle:dba /u01/oracle [Enter]   

Create the Oracle installation dire

# mkdir -p /u01/app/oracle [Enter]   

# chown oracle:oinstall /u01/app/oracle [En

You must now copy the database scripts. 

To copy the Product Interchange database utilities:   

Change to the Orac

# su - oracle [Enter] 

$ mkdir /u01/oracle/agilepitmp [Enter] 

Insert the Agile installatio
the agilepitmp direct

$ cd /cdrom [Enter]   

For Oracle 9i:$ cd /CD1_Agile/Solaris/DB/Oracle9i
For Oracle 10g:$ cd /CD1_Agile/Solaris/DB/O
$ cp pidb.tar.Z /u01/oracle/agilepitmp [Enter] 

Change to the agilepitmp directo

$ cd /u01/oracle/agilepitmp [Enter

$ uncompress pidb.tar.Z [Ent

Extract the pidb.tar file:   

$ tar -xvf pidb.tar [Enter]   

The pidb.tar file contains the following files: 
 pidb.sh — Bourne shell script for creating the databa
 profile.txt — oracle user .profile template 
 system.txt — system kernel parameters 
 dbora — setup for the database automatic sh
 agilepischema.dmp — schema

To modify the system kernel parameters: 

Change to the root user, and ba

$ su -  [Enter] 

# cp /etc/system /etc/system_save [Enter] 
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2. e following /etc/system kernel parameters. If the parameters do not exist, go to the next 

94967295 

 

 

Important o 

these p ocumentation. 

Verify th
step.   

set shmsys:shminfo_shmmax=42

set shmsys:shminfo_shmmin=1 

set shmsys:shminfo_shmmni=100

set shmsys:shminfo_shmseg=10 

set semsys:seminfo_semmns=1024

set semsys:seminfo_semmni=100 

set semsys:seminfo_semmsl=500 

set semsys:seminfo_semopm=100 

set semsys:seminfo_semvmx=32767 

set noexec_user_stack=1 (Note:On Oracle 10g only) 

If you have been running the host computer as an Oracle database server, you have t
check with your Solaris system administrator before changing these parameters. For 

arameter settings, you can also refer to the Oracle d

Note Restart the computer if you modify the /etc/system file. 

3. 
e host computer as the database server. 

Note ed to recover the 

The previous kernel parameters are set in the distributed system.txt file. Append system.txt to 
/etc/system if this is the first time you are configuring th

# cat /u01/oracle/agilepitmp/system.txt >> /etc/system 

Use >> to append. If you have accidentally used >, you ne
original /etc/system file by using cp system_save system. 

4. 

Note il. You may need 

Restart the system to make the new kernel configuration take effect. 

If you do not restart the system, the database creation will fa
to check with your Solaris system administrator for support. 

To set up Oracle environmental variables: 

1. Log in to the system as the Oracle user. 

2. 

:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11 

.0/db_1; export ORACLE_HOME 

ASE 

rt PATH 

Create the environmental parameter file .profile to include:  

PATH=$PATH

export PATH  

(Oracle 9i)ORACLE_HOME=/u01/app/oracle/product/9.2.0SE; export ORACLE_HOME 

(Oracle 10g)ORACLE_HOME=/u01/app/oracle/product/10.2

ORACLE_BASE=/u01/app/oracle; export ORACLE_B

PATH=$PATH:$ORACLE_HOME/bin; expo

ORACLE_SID=pidb; export ORACLE_SID 

TNS_ADMIN=/var/opt/oracle; export TNS_ADMIN 
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NLS_LANG=American_America.UTF8; export NLS_LANG 

The environmental parameters in the previous step are set in the distributed profile.txt file. 
this is the first time you a

3. If 
re configuring the host computer as a database server, copy the 

ter]   

4. mental setting: 

Making the Oracle Installer Available 

 
i

profile.txt file to .profile: 

$ cat agilepitmp/profile.txt > .profile [En

Update the environ

$ . ./.profile [Enter] 

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the
computer.   Use the instructions in Installing Oracle 9  (on page 57) or Installing Oracle 10g (on 

ion CDs. 

Installing the Oracle Database 

page 63) to copy the data from the installat

Use the instructions in Installing Oracle 9i (on page 57) or Installing Oracle 10g (on page 63) to 
install the Oracle database, if it is not already installed. 

Creating the Product Interchange Database 
base instance and schema used by Product 

abase creation utility.       

2.  the .profile file to change Oracle SID. By default, Agile uses pidb as the 

Important as not 
bee

Note acters. This avoids lengthy 

This section describes how to create the default data
Interchange using the dat

To start the installation:     

1. Log in to the computer as the Oracle user. 

If necessary, edit
Oracle SID:        

$ vi .profile [Enter]   

3. Modify the value where ORACLE_SID=pidb by replacing pidb with the SID you want to use. 

Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID h
n used. Specifying an existing Oracle SID can corrupt that database instance. 

Generally, the SID length is four alphanumeric char
database filenames for associated database files. 

4. Run s take effect: 

 the computer as the root user. 

6. e a 

Note 

 .profile to make the SID change

$. ./chmod u+x .profile    [Enter]    

5. In a second terminal session, log in to

Creat directory named “oradata.” 

The pidb.sh file uses a dummy mount point /mpt. You must change /mpt to 
match your mount points. For OFA compliance, it is highly recommended that 
you create at least four mount points (preferably on four different disks across 
multiple controllers) to optimize disk I/O. 
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For example, if you have mount points at /u01 and /u02, you can create an oradata folder 
 

7. ion where you are logged in as the Oracle user, create a $ORACLE_BASE/admin 

er] 

9. ts on your computer, and then copy the script 

Important hes the one you set for .profile, which should have taken 
effec

Note 

on each mount point.

# mkdir -p /u01/oradata
# chown oracle:dba /u01/oradata

In the sess
directory: 

$ mkdir -p /u01/app/oracle/admin [Ent

You must now run the pidb.sh script. 

8. Change to the /u01/oracle/agilepitmp directory. 

Modify the pidb.sh script to match the mount poin
to the Oracle user home directory (/u01/oracle). 

Make sure ORACLE_SID matc
t after you ran . ./.profile. 

The pidb.sh file uses a dummy mount point /mpt. You must change /mpt to 
match your mount points. For OFA compliance, it is highly recommended that 
you create at least four mount points (preferably on four different disks across 
multiple controllers) to optimize disk I/O. 

The values in the script that can be modified appear in bold. You should limit your editing only 

.sh and quickly 
     

sh | sed -e "s/mpt\//u01\//g" > /u01/oracle/pidb.sh
od u

Note iable in bold that you may want to revise besides 

to these bold values. 

For example, if you have a mount point created at /u01, you can modify pidb
recreate it in the Oracle user home directory by issuing one command.   

$ cat /u01/oracle/agilepitmp/pidb.
$ chm +x /u01/oracle/pidb.sh

The following code list var
dummy mount point /mpt 

#!/bin/sh 

================ 

07 Agile Software Corporation 

All Rights Reserved. 

 

ny actual or intended publication of  

========================================================= 

racle_sid default as pidb 

# 

#  =========================================

#  Copyright (c) 1995-20

#  

# 

#  This is unpublished proprietary source code of Agile

#  Software Corporation. The copyright notice above  
#  does not evidence a
#  such source code. 

#  

# 

# O
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# 

ORACLE_SID=pidb     # Oracle SID for the database 

AASYSPW=oracle       # Oracle sys passwd for the database 

AASYSTEMPW=manager   # Oracle system passwd for the database 

chema 

hema 

EPW=dwe         # Oracle passwd for DWE 

cation of datafiles,  
ontrolfiles and logfiles 

e

X tablespace

TABASE_ARCHIVE=/mpt/oradata/${ORACLE_SID}/arch  #ARCHIVELOGS

Parameters determine character set used 

PIUSER=piuser      # Oracle account for piuser s

PIUSERPW=piuser   # Oracle passwd for piuser 

DWE=dwe           # Oracle account for DWE sc

DW

# 

# Parameters determine lo
# c

# 
DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID} # SYSTEM tablespace

DATABASE_SYSAUX=/mpt/oradata/${ORACLE_SID} # SYSAUX tablespace

DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID}  # TOOLS tablespac

DATABASE_UNDO=/mpt/oradata/${ORACLE_SID}   # RBS tablespace

DATABASE_TEMP=/mpt/oradata/${ORACLE_SID}   # TEMP tablespace

DATABASE_USERS=/mpt/oradata/${ORACLE_SID}  # USERS tablespace

DATABASE_INDX=/mpt/oradata/${ORACLE_SID}   # IND

DATABASE_AGILE_DATA1=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX1=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX2=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_DATA4=/mpt/oradata/${ORACLE_SID}

DATABASE_AGILE_INDX4=/mpt/oradata/${ORACLE_SID}

DATABASE_LOGFILES1=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 1

DATABASE_LOGFILES2=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 2

DATABASE_LOGFILES3=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 3

DATABASE_LOGFILES4=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 4

DATABASE_CONTROL1=/mpt/oradata/${ORACLE_SID}   # CONTROL file 1

DATABASE_CONTROL2=/mpt/oradata/${ORACLE_SID}   # CONTROL file 2

DATABASE_CONTROL3=/mpt/oradata/${ORACLE_SID}   # CONTROL file 3

DA

#

# 
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#

CHARACTER_SET=UTF8

NATIONAL_CHARACTER_SET=UTF8

10. .sh script from the Oracle user home directory: 

pischema.dmp . [Enter] 

b.sh

Note  you may have to give the system user full 

Run the pidb

$ cd [Enter] 

$ cp agilepitmp/agile
$ ./pid  [Enter] 

If you are unable to create files,
privileges to the u01 directory. 

11. 

tions 
 that the computer meets the minimum 

 database size. 

Important 
se. It is recommended to change these passwords periodically for 

12. Continue to the next section for post-installation tasks. 

Post-Installation Tasks 
re Oracle Net Manager, and set the automatic startup and 

Setting Up Oracle Net Manager 

1. he /var/opt/oracle directory: 

2. user, and change to the Oracle network directory: 

3.  to the directory defined by environmental parameter TNS_ADMIN, which is 

$ mv * /var/opt/oracle [Enter] 

You are prompted about the database size that you want to install. 

You should use the regular database size unless you have consulted with an Agile Solu
Consultant or database administrator to ensure
requirements for the specified

The script will run for awhile. 

Change all Oracle database user passwords after you have created the Product 
Interchange databa
security purposes. 

 

This section describes how to configu
shutdown features for the database. 

To set up Oracle Net Manager: 

Log in as root and change the ownership of t

# chown -R oracle:dba /var/opt/oracle [Enter] 

Switch to the Oracle 

# su - oracle [Enter]   

$ cd Oracle_Home [Enter] 

Move all the files
/var/opt/oracle: 
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Setting Up Automatic Shutdown and Startup for the Database 

To set up the Oracle database to automatically shut down and start up when the host computer starts up and 
shuts down: 

1. Log in the system as root. 
2. Create a file named “dbora” in the /etc/init.d directory:  

# cat /u01/oracle/agilepitmp/dbora > /etc/init.d/dbora [Enter] 

3. Link to the dbora file:    

# ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora  [Enter]   

# ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora  [Enter]   
 

Configuring the listener.ora File 

To configure the listener.ora file:         

1. Start Net Manager: 

$ netmgr &
2. Within the Local folder, open the Listeners folder and select LISTENER. 

1. Check to see if the following settings appear in one of the Address tabs: 
 Protocol: TCP/IP 
 Host: the host computer where the Oracle database is installed 
 Port: 1521 

1. If the information does not appear, click Add Address. A new Address tab appears. 

2. Type these settings: 
 Protocol: TCP/IP 
 : the host computer where the Oracle database is installed Host

e Directory: Oracle_Home 

work Configuration to save your changes. 

4. Close Net Manager. 

Configuring the tnsnames.ora File (Optional) 
1.  Net Manager window, double-click the Local folder and select the Service Naming 

folder.       

 Port: 1521 

Listener Location1. Select Database Service in the  drop-down list. 

ialog box that appears, make the following changes: 2. Click Add Database. In the d
 Global Database Name: pidb 
 Oracle Hom
 SID: pidb 

3. Choose File > Save Net

 

In the Oracle
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2. Click Create  in the toolbar to add a service name. 

The Net Service Name Wizard starts.    

3. In the Net Service Name field, type the name of the computer where the Oracle database is 
located (usually the current computer). Click Next.      
You are prompted to select a network protocol. Select 4. ocol) and click Next. 

 same name 
 as the default port number. Click Next. 

6.  Click Next. 

8. 

n the Username field and piuser in the Password field. Click OK. 
dicating that the test was successful.    

12. From the Net Manager menu, choose File > Save Network Configuration to save the service name. 

This completes the installation and configuration for Oracle on Solaris. 

TCP/IP (Internet Prot
5. Type the name of the computer where Oracle is located in the Hostname field (the

you typed in step 3). Accept 1521
Select Oracle8i or later as the service name, and type pidb in the field.

7. Click Test to test the service. 

The test initially fails because the default uses the incorrect login.    

Click Change Login to reset the username and password.     

9. Type piuser i
  Click Test. You should now see a message in

10. Click Close. 

11. Click Finish to exit the Net Service Name Wizard. 
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Upgrading the Product Interchange Database 

This chapter includes the following: 

 Upgrading the Product Interchange Database .................................................................................................... 53 
 
 

Upgrading the Product Interchange Database 
If you have Product Interchange version 9.0 SP4, 9.0 SP5 Hotfix 1, 9.2, 9.2.1, 9.2.2, 9.2.2.1, or 
9.2.2.2 installed, you can upgrade your database to Product Interchange version 9.2.2.3. 

Before upgrading, you MUST install the Product Interchange application. After installing Product 
Interchange, the directory containing the upgrade scripts is created.  

To install Product Interchange, see the installation guide for your specific application server, 
Installing Agile PLM with Oracle Application Server or Installing Agile PLM with BEA WebLogic. 

Note You can access the latest version of Agile manuals on the Agile Documentation Web site 
(http://docs.agile.com).   

To upgrade the Product Interchange database from version 9.0 SP4 to version 9.2.2.2: 

1. On the database server, backup the Product Interchange database by exporting the piuser and 
dwe schemas. 

2. Open a Command Prompt window on the machine where Product Interchange 9.2.2.1 is 
installed. 

3. Change to the agile_home\AgilePI\upgrade directory. 

4. Log in to SQL*Plus as the piuser: 

sqlplus piuser/piuser@oracle-sid

5. Run the 90sp4to921.sql upgrade script. 

6. Run the 921HF4to921HF13.sql upgrade script. 

7. Back up the upgraded database by exporting the piuser and dwe schemas. 

To upgrade the Product Interchange database from version 9.0 SP5 Hotfix 1 to version 9.2.2.2: 

1. Check to make sure the i2, Arrow, and Avnet data source profiles exist in the Product 
Interchange application. If they do not exist, you need to run additional upgrade scripts in steps 
described below. 

2. On the database server, back up the database by exporting the piuser and dwe schemas. 

3. Open a Command Prompt window on the machine where Product Interchange 9.2.2.1 is 
installed. 

4. Change to the agile_home\AgilePI\upgrade directory. 
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5. Log in to SQL*Plus as the piuser: 

sqlplus piuser/piuser@oracle-sid

6. Run the 90sp5HF1to921.sql upgrade script. 

7. Run the 921HF4to921HF13.sql upgrade script. 

8. If the i2 data source profile needs to be created, run the following script: i2DSProfile.sql. 

If the Avnet data source profile needs to be created, run the following script: 
AvnetDSProfile.sql. 

9. If the Arrow data source profile needs to be created, run the following script: 
ArrowDSProfile.sql. 

10. Back up the upgraded database by exporting the piuser and dwe schemas. 

To upgrade the Product Interchange database from version 9.2 to version 9.2.2.2: 

1. On the database server, back up the database by exporting the piuser and dwe schemas. 

2. Open a Command Prompt window on the machine where Product Interchange 9.2.2.1 is 
installed. 

3. Change to the agile_home\AgilePI\upgrade directory. 

4. Edit the 92to921.sql file with the following steps: 

1. Replace the string @AlterTable.sql with @alterTable921.sql. 
2. Replace the following lines: 

--===== Drop Columns from PmPartMatches =====-- 

@dropColumns.sql; 

 

with 

--===== ADD Columns to PMPartMatches =====-- 

ALTER TABLE PM_PART_MATCHES ADD ( 

  ROHS               VARCHAR2(15) NULL, 

  LEADFREE           VARCHAR2(15) NULL, 

  LAST_ORDER         VARCHAR2(55) NULL, 

  LAST_SHIP          VARCHAR2(55) NULL, 

  TOTAL_WEIGHT       VARCHAR2(55) NULL, 

  PACKAGE_MATERIAL   VARCHAR2(55) NULL, 

  STATUS             VARCHAR2(55) NULL, 

  LIFECYCLE_STAGE    VARCHAR2(55) NULL 

); 

 

ALTER TABLE PM_PART_MATCHES MODIFY PART_URL 
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VARCHAR2(550); 

5. Edit the dropColumns.sql file by removing the following lines at the end of the file: 

ALTER TABLE PM_PART_MATCHES ADD ( 

  ROHS              VARCHAR2(15) NULL, 

  LEADFREE          VARCHAR2(15) NULL, 

  LAST_ORDER        VARCHAR2(55) NULL, 

  LAST_SHIP         VARCHAR2(55) NULL, 

  TOTAL_WEIGHT      VARCHAR2(55) NULL, 

  PACKAGE_MATERIAL  VARCHAR2(55) NULL, 

  STATUS            VARCHAR2(55) NULL, 

  LIFECYCLE_STAGE   VARCHAR2(55) NULL, 

); 

 

ALTER TABLE PM_PART_MATCHES MODIFY PART_URL 

VARCHAR2(550); 

6. Log in to SQL*Plus as the piuser: 

sqlplus piuser/piuser@oracle-sid

7. Change to the agile_home\AgilePI\pidataload\config directory. 

8. Edit the config.properties file with the Agile PLM database details, then save the file. 

Change to the agile_home\AgilePI\pidataload directory. 

9. Run the run92To921Upgrador file with the edited configuration file, as follows: 
run92To921Upgrador \\pidataload\config\config.properties

1.  If all of the previous steps have completed successfully, log in to SQL*Plus and run the 
dropColumns.sql script in the agile_home\AgilePI\upgrade directory. 

2.  Run the 921HF4to921FH13.sql upgrade script. 

 

To upgrade the Product Interchange database from version 9.2.1 to version 9.2.2.2: 

1. On the database server, back up the database by exporting the piuser and dwe schemas. 

2. pen a Command Prompt window on the machine where Product Interchange 9.2.2.1 is 
installed. 

3. Change to the agile_home\AgilePI\upgrade directory. 

4. Log in to SQL*Plus as the piuser: 

sqlplus piuser/piuser@oracle-sid

5. Run the 921HF4to921HF13.sql upgrade script. 

6.  Back up the upgraded database by exporting the piuser and dwe schemas. 
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Appendix A 

Installing Oracle 9i 

This Appendix includes the following: 

 Before Installing Oracle 9i on Windows ............................................................................................................... 57 
 Installing Oracle 9i Release 2 on Windows ......................................................................................................... 58 
 Installing Oracle 9i Release 2 on Solaris ............................................................................................................. 61 

This section describes how to install Oracle 9i on Windows and Solaris. 
 
 

Before Installing Oracle 9i on Windows 
Before installing Oracle, you must: 

 Verify that Windows has been configured correctly.  

 Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert 
the file system if necessary. See Checking the Windows File System (on page 64) for 
directions. 

 Determine the name of the Windows computer where Oracle is to be installed. The target 
installation folder for the Oracle database is recommended to be d:\oracle\ora92.       

Note It is required that the computer on which you are installing the Oracle database 
have at least two physical drives or two partitions. This allows you to place the 
operating system on the C drive and use the D drive for Oracle components. 
The examples in this chapter use a C and D drive. 

 Be sure that you have Administrator privileges within Windows on the computers where you are 
installing Oracle and Agile PLM. 

 Disable disk compression, if you are using it. 

 Disable virus protection, if you are using it. Components used in the installer can be falsely 
identified as being infected and lock up the installation. You can turn the virus protection on 
after the installation is complete. 

The following sections provide more information about these procedures. 

Network Check 

Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.        

Confirming Computer Name and Hostname Identities 

The computer where Oracle is installed must use the same value as both its computer name and its 
DNS hostname. The following procedures can be used to identify the current values. 
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To determine the computer name for Windows:   

1. Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu. 

2. In the System Properties dialog box, click the Computer Name tab. 

3. Note the name listed in the Full Computer Name field. 

Note Windows uses the same name for the computer name and DNS hostname. 
 

Confirming the Server Date 

It is important to adjust the date and time of the computer. The date and time need to be correct 
when you work with your production data. 

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to 
verify the Time Zone setting, too. 

Caution If you change the date or time after Agile PLM has been installed and started, you need to 
stop and restart the application server immediately after the change.       

 

Checking the Windows File System 

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File 
Allocation Table), as NTFS is more robust. 

To determine the file system type: 

1. Check the file system used on the computer. Choose Start > Administrative Tools > Computer 
Management. Under Computer Management in the left pane, expand Storage and select Disk 
Management. 
The Disk Administration windows opens. 

There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with 
the Oracle installation. If your computer uses a FAT or FAT32 file system, Agile recommends 
converting it to NTFS before proceeding. 

Important Converting the file system deletes all current files on the drive. Backup all necessary files 
before converting the file system to NTFS. 

2. right-click on the drive you want to reformat and choose Format in the shortcut menu. 

3. In the File System field, change the file system type to NTFS. 

4. Click Start. 

The process takes several minutes. On completion, restart the system. You can proceed with the 
Oracle installation. 
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Installing Oracle 9i Release 2 on Windows 
These instructions describe how to install and configure Oracle 9i to run with Agile PLM. 

Note Throughout the instructions, default values are shown (such as the installation path or the 
service name). If you change any of these values during the installation, update the 
information specific to your installation where appropriate. 

Important Make sure the Distributed Transaction Coordinator service is stopped. 

 

To install Oracle 9i:     

1. Insert the Oracle database installation CD. You may have to navigate to the CD drive. Click 
Next. 

2. The Oracle Universal Installer welcome screen appears. Click Next. 
The File Locations window appears. 

3.  Make sure the Oracle home folder is on the D drive at d:\oracle\ora92. Click Next. 

Note If you are installing Oracle on a different drive, specify that drive instead. 

The Available Products window appears.    

4. Select Oracle9i Database 9.2.0.1.0. Click Next. 
The Installation Types window appears.     

5. Select Standard Edition. Click Next. 

Note If you have more than 4 CPUs, you must use Oracle 9i R2 Enterprise Edition. 
The Standard Edition license only allows you to install on a server having up to 
4 CPUs. 

The Database Configuration window appears. 

6. Select Software Only. Click Next. 
The Oracle Services for Microsoft Transaction Server window appears. 

7. Accept the default 2030 port number. Click Next. 
8. Review the information to ensure that you have enough disk space. Click Install. 

The Install window appears and displays a progress meter. 

9.  Insert the remaining CDs when prompted and browse to the \stage folder to continue the 
installation. 
 Click Exit when the installation is complete. 

The Add Databases to tree dialog appears. 



 

10.  Click Cancel. 
11.  Choose File > Exit from the Oracle Enterprise Manager Console window. 
 

Editing the sqlnet.ora File 

For databases installed on Windows Server computers, you must check the sqlnet.ora file to make 
sure authentication services are configured correctly. 

To edit the sqlnet.ora file: 

1. Go to the d:\oracle\ora92\network\admin folder. 

2. In a text editor, open the sqlnet.ora file and look for the following parameter: 

SQLNET.AUTHENTICATION_SERVICES
3. If the parameter is set to (None), you do not need to edit the file. 

4. If the parameter is set to (NTS), place a pound symbol (#) at the beginning of the line so it 
appears as follows: 

# SQLNET.AUTHENTICATION_SERVICES= (NTS)

Note If you do not want to comment out the line, you can change (NTS) to (NONE). 

5. Save and close the file. 

This completes the Oracle installation. You must now create the Agile database as described in 
Using the Agile Database Configuration Utility (on page 13). 

Making the Oracle Installer Available on Solaris 

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the 
Solaris computer. 

Note Oracle 9i Release 2 (9.2.0.1.0) uses three CDs. To avoid changing CDs during the 
installation, you should create an area containing the Oracle installation files.     

To copy the Oracle installer onto the computer: 

1. Log in as root, and create the stage folder: 

# mkdir /u01/oracle/stage [Enter] 

2. Insert the first installation CD for Oracle on Solaris. 

Solaris automatically mounts the CD to the mounting point /cdrom. 

3. Change to the cdrom folder: 

# cd cdrom [Enter] 

# ls [Enter] 

4. Copy the first Oracle CD to the stage folder: 

# cup -r /cdrom/orcl9201_1 /u01/oracle/stage/. [Enter] 

5. Eject the Oracle CD and insert the second Oracle CD. 

6. Copy the second installation CD to the stage folder: 
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# cup -r cdrom/orcl9201_2 /u01/oracle/stage/ [Enter] 

7. Eject the second Oracle CD and insert the third Oracle CD. 

8. Copy the third installation CD to the stage folder: 

# cp -r cdrom/orcl9201_3 /u01/oracle/stage/ [Enter] 

Continue with installing Oracle 9i Release 2. 

Installing Oracle 9i Release 2 on Solaris 
This section describes how to install Oracle 9i Release 2 on Solaris. You install the Agile database 
after you install the Oracle software. 

To install Oracle: 

1.  Log in to the computer as the Oracle user. 

2.  Change to the /u01/oracle/stage/orcl9201_1 directory, and run the installer: 

$ cd /u01/oracle/stage/orcl9201_1 [Enter] 

$ ./runInstaller &   [Enter] 

Note You may have to set the DISPLAY environmental variable to get the installer to 
start. If you have problem setting up the DISPLAY variable, check with your 
Solaris system administrator. 

3. The Welcome screen appears. Click Next. 
4. If this is the first time any Oracle products have been installed on this computer, you are 

prompted for the inventory location which is the base directory where all Oracle files will reside. 
Click OK to accept the default location. 

5. If this is the first time any Oracle products have been installed on this computer, you are 
prompted for the Solaris group name. Type oinstall and click Next. 
A window appears prompting you to run the orainstRoot.sh script. 

Open another terminal session, and log in to the system as root. 
Run the orainstRoot.sh script. 

Leave the terminal session window open. 

After the script finishes, return to the Oracle installation window and click Continue. 

6. Make sure the ORACLE_HOME directory is /u01/app/oracle/product/9.2.0SE. Click Next. 
The Available Products window appears.    

7. Select Oracle9i Database 9.2.0.1.0. Click Next. 
The Installation Types window appears.     

8. Select Standard Edition. Click Next. 



 

The Database Configuration window appears. 

9. Select Software Only. Click Next. 
A summary appears showing all selected settings. 
  Click Install. A message appears saying that the installation is continuing. 

10. After the installer completes the installation with the first disk, you are prompted for the location 
of the second disk. Type /u01/oracle/stage/orcl9201_2/ and Click OK to continue. 

11. After the installer completes the installation with the second disk, you are prompted for the 
location of the third disk. Type /u01/oracle/stage/orcl9201_3/ and Click OK to continue. 

When the installation finishes, the Setup Privileges window appears and prompts you to run the 
root.sh script as root. 

12. In the second terminal session, log in the system as the root user. Change to 
$ORACLE_HOME: 

# cd /u01/app/oracle/product/9.2.0SE [Enter] 

# ./root.sh  [Enter]   

13. Press Enter to accept /usr/local/bin as the local bin directory. 

14. Return to the Oracle installation window, and Click OK. 

The End of Installation dialog box appears. 

15. Click Exit and then Yes when the verification dialog box appears. 

The Add Databases to tree dialog appears. 

16. Click Cancel. 
17. Choose File > Exit from the Oracle Enterprise Manager Console window. 

This completes the Oracle installation. You must now create the Agile database as described in 
“Creating the Agile Database”. 
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Appendix B 

Installing Oracle 10g 

This Appendix includes the following: 

 Before Installing Oracle 10g on Windows............................................................................................................ 63 
 Network Check .................................................................................................................................................... 63 
 For Servers Configured with DHCP..................................................................................................................... 65 
 Installing Oracle 10g Release 2 on Windows ...................................................................................................... 66 
 Making the Oracle Installer Available on Solaris ................................................................................................. 67 
 Making the Oracle Installer Available on Linux.................................................................................................... 68 
 Installing Oracle 10g Release 2 on Solaris and Linux ......................................................................................... 69 

This section describes installing Oracle 10g on Windows, Solaris, and Linux. 
 
 

Before Installing Oracle 10g on Windows 
Before installing Oracle, you must: 

 Verify that Windows has been configured correctly. See Checking the Windows File System for 
directions. 

 Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert 
the file system if necessary. See Checking the Windows File System (on page 64) for 
directions. 

 Determine the name of the Windows computer where Oracle is to be installed.        

Note It is required that the computer on which you are installing the Oracle database 
have at least two physical disks or two logical partitions. This allows you to 
place the operating system on the C drive and use the D drive for Oracle 
components. The examples in this chapter use a C and D drive. 

 Be sure that you have Administrator privileges within Windows on the computers where you are 
installing Oracle and Agile PLM. 

 Disable disk compression, if you are using it. 

 Disable virus protection, if you are using it. Components used in the installer can be falsely 
identified as being infected and lock up the installation. You can turn the virus protection on 
after the installation is complete. 
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Network Check 
Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.        

Confirming Computer Name and Hostname Identities 

The computer where Oracle is installed must use the same value as both its computer name and its 
DNS hostname. The following procedures can be used to identify the current values. 

To determine the computer name for Windows:   

1.  Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu. 

2.  In the System Properties dialog box, click the Computer Name tab. 

3.  Note the name listed in the Full Computer Name field. 

Note Windows uses the same name for the computer name and DNS hostname. 
 

Confirming the Server Date 

It is important to adjust the date and time of the computer. The date and time need to be correct 
when you work with your production data. 

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to 
verify the Time Zone setting, too. 

Caution If you change the date or time after Agile PLM has been installed and started, you need to 
stop and restart the application server immediately after the change.       

 

Checking the Windows File System 

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File 
Allocation Table), as NTFS is more robust. 

To determine the file system type: 

1. Check the file system used on the computer. Choose Start >  Administrative Tools > Computer 
Management. Under Computer Management in the left pane, expand Storage and select Disk 
Management. 
The Disk Administration windows opens. 

There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with 
the Oracle installation. If your computer uses a FAT or FAT32 file system, Agile recommends 
converting it to NTFS before proceeding. 

Important Converting the file system deletes all current files on the drive. Backup all necessary files 
before converting the file system to NTFS. 

2. right-click on the drive you want to reformat and choose Format in the shortcut menu. 

3. In the File System field, change the file system type to NTFS. 

64 Agile Product Lifecycle Management 

 



 

 65 

 

 

 

 

4. Click Start. 

The process takes several minutes. On completion, restart the system. You can proceed with the 
Oracle installation. 

For Servers Configured with DHCP 
If your server is configured with DHCP (Dynamic Host Configuration Protocol), there is a known 
issue with the Oracle 10g installation. The installation fails and the following message displays: 

Thrown When the IP address of a host can not be determined

There are two possible solutions: 

1. Copy the Oracle 10g installation software to your local disk and perform an off-network 
installation OR 

2. Install the Microsoft Loopback adapter on the DHCP server, then add one entry to the hosts 
file. 

To install the Microsoft Loopback adapter: 

1. Click Start > Control Panel > Add/Remove Hardware. 

The Add/Remove Hardware wizard appears. 

2. Click Next. 
3. Choose Yes, I have already connected the hardware, then click Next. 
4. Choose Add a new hardware device, then click Next. 
5. Choose Install the hardware that I manually select from a list, then click Next. 
6. elect Network adapters, then click Next. 
7. In the Manufacturers list, select Microsoft. 
8. In the Network Adapter list, select Microsoft Loopback Adapter, then click Next. 
9. Click Next to install the adapter. 

10. Click Finish. 

To configure the hosts file: 

1. Open the hosts file, located at C:\Windows\System32\drivers\etc. 

2. Add the following entry to the hosts file: 10.10.10.10 hostname.domain hostname 

For example, if the full machine name of your database server is db1.agile.agilesoft.com, the 
entry in the hosts file would be: 
10.10.10.10 db1.agile.agilesoft.com db1 

3. Save the file. 



 

To configure the loopback IP address on the network: 

1. On the database server, right-click the My Network Places icon. 

2. Choose Properties to display the Network and Dial-up Connections window. 

3. Locate a connection with the device name of Microsoft Loopback Adapter. This connection is 
usually Local Area Connection 2. 

4. right-click this connection icon. 

5. Choose Properties to display the Local Area Connection 2 Properties dialog box. 

6. On the General tab, select Internet Protocol (TCP/IP), then click Properties to display the Internet 
Protocol (TCP/IP) properties dialog box. 

7. On the General tab, choose Use the following IP Address. 

8. Enter the following values: 

IP address: 10.10.10.10 

Subnet mask: 255.255.255.0 

9. Click OK. 

10. Click Close. 

On completion, restart the system. You can proceed with the Oracle installation. 

Installing Oracle 10g Release 2 on Windows 
These instructions describe how to install and configure Oracle 10g to run with Agile PLM. The 
Oracle 10g installation for Agile PLM requires the database software and the Oracle Text 
Knowledge component contained on the Oracle 10g Release 2 Companion CD. 

Note Throughout the instructions, default values are shown (such as the installation path or the 
service name). If you change any of these values during the installation, update the 
information specific to your installation where appropriate. 

Important Make sure the Distributed Transaction Coordinator service is stopped. 

To install Oracle 10g:          

1. Insert the Oracle database installation CD. You may have to navigate to the CD drive. 

2. double-click the Setup icon. 

The Oracle Universal Installer command window and welcome screen appear. 

3. Click Next. 
The Installation Method window appears. 

4. Select Basic Installation. Make sure the Oracle Home Location is on the D drive at 
d:\oracle\product\10.2.0\db_1 which is the default if you have two disks. 

5. Select Standard Edition as the Installation Type. Click Next. 

Note  Do not check Create Starter Database.You will create the Agile database with 
the Database Configuration Utility. 
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The Product Specific Prerequisite Checks window appears.    

6. The Oracle Universal Installer verifies that your server meets the minimum requirements for 
installing and configuring the options you have selected. If your system passes, a summary 
window appears. Click Next. 

7. Click Install. 
8. Click Exit when the installation is complete. 

After you install the database software, you must use the Oracle 10g Release 2 Companion CD to 
install Oracle Text, a product required by the full text search functionality of Agile PLM. 

To install the Oracle 10g Companion products: 

1. Insert the Oracle 10g Companion CD. You may have to navigate to the CD drive. 

2. double-click the Setup icon. 

The Oracle Universal Installer command window and welcome screen appear. 

3. Click Next. 
The Select a Product to Install window appears. 

4. Click Oracle Database 10g Products 10.2.0.1.0. Click Next. 
The Specify Home Details window appears. 

5. Select the Oracle Home where you installed the Oracle 10g database. Click Next. 
The Product Specific Prerequisite Checks window appears.    

6. The Oracle Universal Installer verifies that your server meets the minimum requirements for 
installing and configuring the options you have selected. If your system passes, a summary 
window appears. Click Next. 

7. Click Install. 
8. Click Exit when the installation is complete. 

This completes the Oracle installation. You must now create the Agile database as described in 
Using the Agile Database Configuration Utility (on page 13). 

Making the Oracle Installer Available on Solaris 
To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the 
Solaris computer. 

Note Oracle 10 Release 2 (10.2) includes the database and companion CDs.      

To copy the Oracle software onto the computer: 

1. Log in as oracle, and create the software folder: 

# mkdir /u01/oracle/software [Enter] 



 

Note This step assumes you have created the user oracle with the home directory 
/u01/oracle. 

2. Copy or FTP the following two files in binary mode from the CDs to the software directory: 

10gr2_db_sol.cpio.gz 

10gr2_companion_sol.cpio.gz 

3. Change to the software directory and unzip the files as follows: 

$ gunzip 10gr2_db_sol.cpio.gz [Enter] 

$ gunzip 10gr2_companion_sol.cpio.gz [Enter] 

4. Create the CD directories: 

$ mkdir database [Enter] 

$ mkdir companion [Enter] 

5. Copy the database CD contents to the database directory: 

$ cd /u01/oracle/software/database [Enter] 

$ cpio -idmv</u01/oracle/software/10gr2_db_sol.cpio [Enter] 

6. Copy the companion CD contents to the companion directory: 

$ cd /u01/oracle/software/companion [Enter] 

$ cpio -idmv</u01/oracle/software/10gr2_companion_sol.cpio [Enter] 

Continue with installing Oracle 10g Release 2. 

Making the Oracle Installer Available on Linux 
To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the 
Linux computer. 

Note Oracle 10 Release 2 (10.2) includes the database and companion CDs.      

To copy the Oracle software onto the computer: 

1. Log in as oracle, and create the software folder: 

# mkdir /u01/oracle/software [Enter] 

Note This step assumes you have created the user oracle with the home directory 
/u01/oracle. 

2. Copy or FTP the following two files in binary mode from the CDs to the software directory: 

10201_database_linux32.zip 

10201_companion_linux32.zip 

3. Change to the software directory and unzip the files as follows: 

$ unzip 10201_database_linux32.zip [Enter] 

$ unzip 10201_companion_linux32.zip [Enter] 
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Continue with installing Oracle 10g Release 2. 

Installing Oracle 10g Release 2 on Solaris and Linux 
This section describes how to install Oracle 10g Release 2 on Solaris and Linux. You can install the 
Agile database after you install the Oracle software. 

To install Oracle: 

1. Log in to the computer as the Oracle user. 

2. Change to the /u01/oracle/software/database directory, and run the installer: 

$ cd /u01/oracle/software/database [Enter] 

$ ./runInstaller &   [Enter] 

Note You may have to set the DISPLAY environmental variable to get the installer to 
start. If you have problem setting up the DISPLAY variable, check with your 
Solaris system administrator. 

3. The Welcome screen appears. Click Next. 
The Installation Method window appears. 

4. Select Basic Installation. 

5. Select Standard Edition as the Installation Type. Click Next. 

Note Do not check Create Starter Database. 

6. If this is a new Oracle installation, the Specify Inventory Directory and Credentials window 
appears. Accept the defaults and click Next. 
The Product Specific Prerequisite Checks window appears.    

7. The Oracle Universal Installer verifies that your server meets the minimum requirements for 
installing and configuring the options you have selected. If your system passes, a summary 
window appears. 

8. Click Install. 
9. Click Exit when the installation is complete. Now, you can install the companion CD. 

10. Change to the /u01/oracle/software/companion directory, and run the installer: 

$ cd /u01/oracle/software/companion [Enter] 

$ ./runInstaller &   [Enter] 

The Oracle Universal Installer command window and welcome screen appear. 

11. Click Next. 
The Select a Product to Install window appears. 

12. Click Oracle Database 10g Products 10.2.0.1.0. Click Next. 



 

The Specify Home Details window appears. 

13. Select the Oracle Home where you installed the Oracle 10g database. Click Next. 
The Product Specific Prerequisite Checks window appears.    

14. The Oracle Universal Installer verifies that your server meets the minimum requirements for 
installing and configuring the options you have selected. If your system passes, a summary 
window appears. 

15. Click Install. 
16. Click Exit when the installation is complete. 

This completes the Oracle installation. You must now create the Agile database as described in 
Creating the Agile Database (on page 21). 
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Appendix C 

Database Management 

This Appendix includes the following: 

 Database Maintenance........................................................................................................................................ 71 
 Backing Up the Database .................................................................................................................................... 72 

It is important to protect your Agile data and system files from loss. This section describes basic 
backup and recovery strategies and gives specific information about applying them to your Agile 
system used with Oracle products. 

The instructions in this section are for system and database administrators who need to manage the 
Agile database. 
 

Database Maintenance 
This section provides database maintenance procedures. 

Fine-Tuning Index Settings 

Depending on your database server and the fields most frequently searched at your site, you may 
speed up searches by using an SQL script to create additional database indexes. If you are 
experiencing noticeably slow performance when searching on certain fields, contact Agile Technical 
Support to see if index modifications might help.   Note that an added index needs to be analyzed 
for statistics, otherwise, the cost-based optimizer may not use it.      

Monthly Maintenance 

Plan for a regular monthly cold backup of your database as a maintenance measure.         

Note An export of the Agile database may not be sufficient because a file content index 
synchronization is needed after data is imported to the database server. 

 

Checking Database Space Allocation 

Checking the tablespace data files in your Oracle database on a monthly basis can help determine 
how close your database storage is to maximum capacity. If any or all of the tablespaces are at 
least 90 percent, you should do the following: 

 Frequently export the agile schema to view the dump file size. You may need to consider 
migrating to a larger database sizing model. 

 Increase the disk space allocation for the specific tablespaces. One method for accomplishing 
this is to increase the data file size for the corresponding tablespaces, as follows: 

1. Check the disk space for the hard drive where the Oracle database is located. 
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2. If there is less than 500 MB available, it is recommended that you increase disk space by 
adding to or replacing the hard drive. 

3. To check the tablespace data files, start the Enterprise Manager Console. The Oracle Enterprise 
Manager Login dialog box appears. 

4. Select Launch standalone and Click OK. 

5. double-click the Databases folder and the name of the database. 

6. Log in as follows, and then Click OK: 

Username: system
Password: manager
Service: hostname (remote) or blank (local) 

Connect As: normal 

Note Type the fully qualified hostname of the computer in the Service field (or Host 
String in some cases) if you are not logging in on the same computer where you 
have installed Oracle or if you receive a TNS error message. 

7. Under Storage > Tablespaces, select System, Temporary, Agile_DATA1-4, and Agile_INDX1-4 and 
determine if the amount of disk space each tablespace is using exceeds 90 percent. Make sure 
Agile_INDX4 has enough space for file content index synchronization. 

Note If you need to increase the amount of available disk space, double-click the 
value in the Size field. 

8. The Edit Datafile dialog box appears. Increase the amount of available disk space, and then 
Click OK. 

If possible, you should double the current disk space. If the disk space is not available on the 
hard drive, you should consider upgrading your hardware. 

Note This is a preventive and proactive measure, but is not required. All Agile 
tablespaces automatically extend by 10MB whenever additional disk space is 
needed and available. 

 

Dynamic Versus Static IP Addresses 

You can use dynamic IP addresses with “long-term lease” assignments, as well as static addresses, 
for Oracle systems. For best results, do not change the hostname of computers in the system, and 
use static IP addresses.       

Backing Up the Database 
You should institute routine backups of all servers. Agile recommends backing up entire disks to 
save both database and registry data.      

Database losses are unfortunate, but they can and do occur. They can result from hardware 
failures, natural disasters, fire, power surges, and problems with administration and configuration. 
Whatever their cause, your best protection against business disruption and permanent data loss is 
an effective backup and recovery plan, applied as automatically as possible. 

This chapter introduces several ways to back up and recover data. You will need additional 
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information to adequately administer and protect your database. You may need to do a cost/benefit 
analysis to determine how often to back up critical data and to justify the labor, hardware, software, 
and storage costs involved. The following documents may be helpful:       

 Oracle9i User-Managed Backup and Recovery Guide or Oracle Database Backup and 
Recovery Basics 10g Release 2 

 Oracle9i Recovery Manager User's Guide 

 Oracle9i Database Concepts or Oracle Database Concepts 10g Release 2 

 Legato Storage Manager Administrator's Guide 

Note The documents are available at Oracle’s Web site: 

http://otn.oracle.com/documentation/oracle9i.html 
(http://otn.oracle.com/documentation/oracle9i.html) 

http://www.oracle.com/technology/documentation/database10gR2.html 
(http://www.oracle.com/technology/documentation/database10gR2.html) 

You must be a member of the Oracle Technology Network to have access to the site 
(becoming a member requires simply that you register at the site to gain access). 

Backup and Recovery Strategy 

When you are planning a backup and recovery strategy, you need to consider the following factors:        

 Database availability 

What is the database availability requirement for business operations? Is it required for 
7X24X365 availability or only during standard business hours? 

According to the availability requirement, different database backup methods can be adopted. If 
the database cannot be shut down, a hot online backup is the only choice. 

 ARCHIVELOG and NOARCHIVELOG mode 

A database can run in ARCHIVELOG or NOARCHIVELOG mode. 

When the database is in operation, all database changes are recorded in redo log files. If the 
database is running in ARCHIVELOG mode, these redo log files are archived in the database 
archive log destination and are referred to as archived redo log files. A database running in 
ARCHIVELOG mode provides better protection from data loss. It can be recovered up to the 

. point of failure. To perform a hot backup, a database must be running in ARCHIVELOG mode

The default configuration for the Agile database is NOARCHIVELOG mode. You can change 
the database to ARCHIVELOG mode following the instructions available in the initagile9.ora 

le DBA or Oracle support be available. file. It is recommended that an Orac

 

a in the event of a database crash? 

Data loss tolerance 

How much data can you afford to lose due to a database crash? 

Can you afford to lose one day or one week’s worth of dat
Can you re-enter user data if there is a database failure? 

http://otn.oracle.com/documentation/oracle9i.html
http://otn.oracle.com/documentation/oracle9i.html
http://www.oracle.com/technology/documentation/database10gR2.html
http://www.oracle.com/technology/documentation/database10gR2.html


 

If your database cannot tolerate data loss due to failure, then a good data protection backup 
pted, such as hot or cold backup using ARCHIVELOG mode. 

 

o disk are much faster than to 
 is also much faster from disk than from tape. 

 

dge than others. Standby databases 
n cold or hot backup. 

 

d features, such as high availability, require more of an investment in hardware 

e 
iled information to help you make these decisions, see the books 

listed on th ge.    

method needs to be ado

Recovery time 

How much time can you afford to spend recovering a database in the event of a crash? 

Different backup methods have different recovery times. Physical methods for backup and 
recovery are much faster than logical backups, and backups t
tape. Recovery

Technical skills 

What are the technical skills of your database or systems administrator? 

Some backup methods require more database knowle
require more technical skill tha

Hardware or software investment 
How much hardware or software investment do you want to put into the system? 

Some advance
and software. 

You can determine the safest backup method for your environment based on database 
requirements, database running mode, and your recovery scenario (as described in the following 
table). However, the final decisions about the backup and recovery strategy you use is beyond th
scope of this chapter. For deta

e previous pa

Scenar io  Backup methods 

The database requires 7X24 
uptime and cannot be shut down 

kup 

st be running in ARCHIVELOG mode  

Hot bac
Export 
 
Database mu

The database is available during
regular busine

 
ss hours and can 

be shutdown 
ckup 

in NOARCHIVELOG or 
G mode 

Hot backup 
Cold ba
Export 
 
Database can running 
ARCHIVELO

To recover up to the point of 
ckup with ARCHIVELOG mode  

Hot backup 
failure Cold ba

To recover an individual user or Export 
table 

For fast recovery 
Cold backup 
Hot backup 
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 h site can be backed 

 t you export and re-import the database on a monthly basis to maintain 
optimum performance. 

efault data; these names might differ if 
custom nam stead of the defaults.     

Implementing Backup Procedures 

For best backup results, follow these guidelines: 

 Schedule online backups when there is minimal database access. 

 Have a fixed schedule for online backups so users can plan for database slowdowns. 

 Test your backup strategy to see if it is effective; make changes if any area is weak. 

 Plan to save at least one version back; choose to retain enough versions for your business 
needs. 

 Perform database consistency checks just before export or after import. 

 Back up the master database before and after it is altered; if you save the original database 
creation scripts, you can use the same scripts to recreate it. 

For a distributed system, plan on coordinating backup procedures so eac
up individually without destroying the integrity of the data at other sites. 

Oracle recommends tha

 

Useful Information for Backup and Maintenance Tools 

If you use Oracle tools such as SQL Plus or third-party backup tools, you need to enter information 
about the Oracle database installation. The table below lists d

es were used in      

Oracle  F ie ld  Defau l t  Data  Custom Data  

Oracle Sys account password oracle  

Oracle System account password manager  

Oracle Ctxsys account password ctxsys  

Oracle database Agile account username agile  

Oracle database Agile account password tartan  

Oracle database host name rver hostnameAgile se  

Oracle database instance agile9  

 

is ollowing types of backups:        

 

 

Types of Backups 

Th  section describe the f

 Registry file backups



 

 System backups 

 Standby database backups 

 Standard database backups 

System administrators often perform the first two types of backups, and database administrators 

s located at 

(DBAs) perform the last two types of backups. 

The last three types of backups should include backing up the Agile server file
\\Agile_dir\Agile9. These are the files needed to run Agile and the attachments to the Agile 
database. They should also include backing up the Oracle files located in the 
\\oracle\oradata\instance_name folder. 

Third-party backup procedures, such as Cheyenne Software’s ArcServe, are not described in this 
chapter. However, if you are using one, see “Useful Information for Backup and Maintenance Tools 

me and other Oracle database information. 

You typically perform a system backup on a small system. You bring down the entire system, 

own the system, start it up again in single-user or maintenance 
, as follows: 

nce) mode. 

ty. 

ess. 

ti-user mode. 

ded. 

, 
s as a backup when it resides 

o a system residing locally or 

(on page 75)” for the default userna

Performing System Backups 

including all the programs, data files, and log files. Typically, a system backup is run each night.      

To perform a system backup, shut d
mode, then copy system files to tape

1. Shut down active applications. 

2. Shut down the relational database. 

3. Stop the Agile Application Server process. 

4. Bring the system back in single-user (maintena

5. Back up all disks to tape with a suitable utili

6. Start the Agile Application Server proc

7. Start the system in mul

8. Restart the database. 

9. Restart applications as nee
 

Using Standby Databases 

Typically, a standby database is run on a large system. The standby database feature maintains a 
duplicate database of your primary online database at the same location or at a remote site. (Both 
the standby database and the primary database must be running on the same hardware platform
operating system, and Oracle patch release.) A standby database act
locally, and is implemented as part of a database disaster recovery strategy when it resides at a 
remote site. The standby database has the following features:           

 It is copied from the primary or current production database ont
remotely. 

 It is mounted, but not open, and is in constant recovery mode. 

 Redo log files generated from the primary database can be transported to the standby 
database, and the standby database can apply these logs to recover the database. 
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up and configure. For more information, see the references 

 In the event of a disaster, a standby database can be activated and fully functional as a new 
production database. 

A standby database takes time to set 
suggested in “Exporting the Database (on page 80)”. 

Typ

 

de 

 

kup, the database tablespace must first be put in backup mode, 
, the 

 
ps 

backups,

Performing Database Backups 

ically, you run a standard database backup daily. Databases backups can be:       

Cold or offline, where the database is shut down before copying database-related files: control 
files, data files, redo log files, initial parameter file (initagile9.ora), spfileagile9.ora, and 
password file(pwdagile9.ora). A database running in ARCHIVELOG or NOARCHIVELOG mo
can be backed up by a cold backup (NOARCHIVELOG mode permits only cold backups). 

Hot or online, where a backup is performed while the database is open and users are 
accessing it. To perform a hot backup, a database must be running in ARCHIVELOG mode. 
When performing a hot bac
then the datafile can be copied by the operating system. Once the datafile has been copied
database tablespace can be placed online again. This allows the database to be backed up 
tablespace by tablespace. 

A logical backup creates logical copies of database objects in a binary export file. Logical 
backu use the agile9 database utilities, agile9exp and agile9imp. When performing logical 

 a database must be open and running. 

Note Oracle EXP and IMP utilities do not export the ctxsys account. So, FTS objects 
will be recreated during an agile9 import. 

For best results, you should timestamp backups and generate scripts to perform them automatically 
using the operating system task schedule command. 

ated files, including data files, control files, 
the password file (pwdagile9.ora), and the 

e9.ora). 

1. 

m copy command to copy all of the database data files, the control file, 
the archived redo log file (if the database is 

For details, see the references suggested in “Exporting the Database

Performing Cold Backups 

Cold backups should be done on all the database-rel
redo log files, the initial parameter file (initagile9.ora),
server parameter file (spfileagil

To perform a cold backup on all database-related files:   

Shut down the database. 

2. Use the operating syste
the initial parameter file, the password file, and 
running in ARCHIVELOG mode) to the backup destination. 

3. Restart the database. 

 (on page 80)”. 



 

Performing Hot Backups 

Hot backups require a setup procedure, after which a backup is created every day. For instr
see the references suggested in 

uctions, 
Exporting the Database (on page 80). 

Importing the Database 

Exporting the Database (on page 80) describes how to create a full backup of your Oracle 
ma. 

e e name or host string, you must provide the fully 

database or a backup only of the Agile sche

Not  If you are prompted for the servic
qualified computer name. 

To import the ma on Windows:        

drive:\agile9tmp\dbvar.txt file and look for the following line: 

. 

4. ve and close the file. 

e following commands use the D drive. If you have installed agile9tmp or 

  scheAgile

1. Confirm that the schema is valid.        
2. In a text editor, open the 

%AGILE%=agile      
3. Change agile to the schema name you want to import, if applicable

Sa

Note Th
Oracle on another drive, specify that drive letter. 

5. r Command Prompt window, and type the following: 

7. mporting the database, you can check import parameters in the agile9imp.par text file, 
whic

file= mp.log fromuser=agile touser=agile indexes=n rows=y ignore=y grants=n 
cons
whe

rsion must match the latest schema 

u user 
must

touse rrent 
value  the data may cause data corruption. 

Open anothe

d:
cd agile9tmp
agile9db.exe

6. In a Command Prompt window, type the following: 

cd oracle\admin\agile9\create
recreateagile.bat
Before i

h contains the following parameters: 

agile9exp.dmp log=agile9i
traints=n statistics=n
re: 

file is the file to import. The DMP file schema ve
version of agile9.exe. 

log is the import log file. 

from ser is the user account in the file that contains the data that will be imported. from
 exist in the DMP file specified by the file. 

r is the user account where the data is being imported. touser must match the cu
 of %AGILE%; otherwise, importing
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e indexes, rows, ignore, grants, constraints, and statistics parameters specify Note Th
other import settings. Do not modify these parameters, and these settings 
should only be used when using the agile9imp script. If a standalone imp is 
used, do not use these settings. 

8. To import the database and recreate indexes and statistics, type the following: 

 to close the Command Prompt window. 

n, call Agile Technical Support. 

agile9imp.bat
9. After the batch file finishes running, type Exit

Note For file content index synchronizatio

To i port the Agile schema on UNIX: m

2. firm that the database schema is valid. 

4. sting database schema. 

gile9tmp directory: 

ile9db.sh
7. script, and find AGILE=agile. 

8.  to the new, unused account name. 

9. 

10. Run 

 Enter R for regular or L for large based on how 

veral SQL scripts and Bourne shell scripts in the following directory: 

ORACLE_SID/create. 

11. nishes running, type the following: 

12. 

e.sh
teagile.sh

13. 
whic  following parameters: 

1. Log in as the Oracle user. 

Con

3. Confirm that the user account name is new. 

Make a backup of the exi

5. Change to the oracle user directory: 

$ cd
6. Copy agile9db from the a

$ cp ./agile9tmp/ag
Edit the agile9db shell 

Change agile

Save and close the file. 

agile9db: 

$ chmod u+x agile9db.sh
$ ./agile9db.sh
You are prompted to choose a database size.
you created the database initially. 

The script creates se

$ORACLE_BASE/admin/$

When the script fi

$ cd $ORACLE_BASE/admin/$ORACLE_SID/create
Run recreateagile: 

$ chmod u+x recreateagil
$ ./recrea
Before importing the database, you can check import parameters in the agile9imp.par text file, 

h contains the



 

file=agile9exp.dmp log=agile9imp.log fromuser=agile touser=agile indexes=n rows=y ignore=y grants=n 

whe

 —
 fromu n the DMP 

file s
 touser s being imported. touser must match the current 

ws, ignore, grants, constraints, and statistics parameters specify 

contraints=n statistics=n
re: 

 file — File to import. The DMP file schema version must match the latest schema version 
of agile9.sh. 

 log  Import log file. 
ser — User account in file that contains data to import. fromuser must exist i
pecified. 
 — User account where the data i

value of $AGILE. Otherwise, importing may cause data corruption. 

Note The indexes, ro
other import settings. Do not modify these parameters, and these settings 
should only be used when using the agile9imp script. If a standalone imp is 
used, do not use these settings. 

14. To import the schema and re

$ chmod u+x agile9imp.sh
create indexes and statistics, type the following commands: 

$ ./agile9imp.sh

Note  For file content index synchronization, call Agile Technical Support. 
 

Exporting the Database 

For maximum data security, you should use
file whenever you need to restore a databa

 a cold backup. You can import the Agile schema DMP 
se or replicate it on another computer with the exception 

 are
uter

Exporting the Full Oracle Database 

e

Note  service name or host string, you must provide the fully 

of file content index synchronization because of its dependence on the file system. 

If you  copying or moving the Agile schema to another computer, you need to set up the 
comp  before importing the Agile schema. 

Wh n you perform a full export, you export all schemas in the Oracle database.       

If you are prompted for the 
qualified computer name. 

To e ws:     

2. 

3. 

S_L
4. Type the ndicated (do not press Enter 

exp system/manager full=y file=”””drive:\agile9tmp\exp_filename.dmp””” 

xport the full Oracle database on Windo

1. Ensure that all system users are logged off. The easiest way to do this is to disconnect the 
server from the network. 

Open a Command Prompt window. 

Set the character set: 

set NL ANG=American_America.utf8
following text with spaces and a triple set of quotes as i

until you have typed the whole text string): 
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log=”””drive:\agile9tmp\exp_filename.log”””   

Note Agile recommends naming the export file expfull.dmp. Replace italics in the 
above syntax with the actual information, for example: 

exp system/manager full=y file="""d:\agile9tmp\expfull.dmp"""  log="""d:\agile9tmp\expfull.log""" 

To e

1. re th t the 
r fro

2. 

ace italics in the 

xport the full Oracle database on Solaris and Linux: 

Ensu at all system users are logged off. The easiest way to do this is to disconnec
serve m the network. 

Enter the following command: 

$ exp system/manager full=y file/u01/oracle/agile9tmp/ exp_filename.dmp log=/u01/oracle/agile9tmp/ 
exp_filename.log

Note Agile recommends naming the export file expfull.dmp. Repl
above syntax with the actual information, for example: 

exp system/manager full=y file=/u01/oracle/agile9tmp/expfull.dmp log=/u01/oracle/agile9tmp/expfull.log

The database export takes awhile. When it completes, open the log file and see if the export was 

You  

Exporting the Agile Schema from Oracle 

base.     

 

successful. If there were problems, call Agile Technical Support. 

 can copy the successful export of expfull.dmp to another secure computer as a backup.

You can export only the Agile schema. This is much faster than exporting the full data

Note If you are prompted for the service name or host string, you must provide the
fully qualified computer name. 

To export only the Agile schema (only Agile data) on Windows:   

1. sure that all users are logged off before shutting down the application server. 

mands use the D drive. If you have installed agile9tmp or 

En

Note The following com
Oracle on another drive, specify that drive letter. 

2. 

3. e, you should check export parameters in the agile9exp.par text 
, 

 log is the export log file. 

Open a Command Prompt window, and type the following: 

d:
cd \o lerac \admin\agile9\create
Before exporting the databas
file which contains the following parameters: 

file=agile9exp.dmp log=agile9exp.log owner=agile
where: 
 file is the file to export. 



 

 owner is the user account that contains data to export. 

To e X:   

m 

2. ts are located: 

ACLE_BASE/admin/$ORACLE_SID/create
3. base, you can check parameters for exporting in a text file named 

ile ns the following parameters: 

. 
ort log file. 

ns data to export. 

$ chmod u+x agile9exp.sh

 it is complete, open the log file and see if the export was 
successful. If there were problems, call Agile Technical Support. 

Oracle 

hemas. The Agile Database 
 by Agile. Additional 

s with different user 

To create ma with a different user account on Windows: 

bvar.txt file and look for the following line: 

3. Cha  to the new, unused account name. 

4. se the file. 

5. mand Prompt window, and type the following: 

4. To export the database, type the following: 

agile9exp.bat

xport only the Agile schema (only Agile data) on UNI

1. Ensure that all users are logged off. The easiest way to do this is to disconnect the server fro
the network. 

Change to the directory where the Agile scrip

$ cd $OR
Before exporting the data
ag 9exp.par, which contai

file=agile9exp.dmp log=agile9exp.log owner=agile
where: 
 file — File to export
 log — Exp
 owner — User account that contai

4. To export the database, type the following command: 

$ ./agile9exp.sh

The database export takes awhile. When

You can copy the successful export of expdat.dmp to another secure computer as a backup. 

Creating a Schema in 

The Oracle database stores data in virtual containers known as sc
Configuration Utility creates the database, user account, and schema used
schemas are not necessary; however, you can create additional Agile schema
names if necessary.               

You should not use the Oracle Security Manager to create users. 

 an ad al agile schedition

count name is new. 1. Confirm that the user ac

2. In a text editor, open the d

%AGILE%=agile      
nge agile

Save and clo

Open a Com

d:
cd agile9tmp
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6. ishes running, type the following: 

ifferent user account on UNIX: 

1. firm that the user account name is new. 

ma. 

3. r directory: 

shell script, and find AGILE=agile. 

6. w, unused account name. 

7. e the file. 

8. 

er R for regular or L for large based on how 

ell scripts in the following directory: 

min/$ORACLE_SID/create. 

9. nning, type the following: 

E/admin/$ORACLE_SID/create

elete the existing instance (such as agile9).           

raHome92TNSListener) and Agile9 service 

figuration Assistant. 

agile9db.exe
When the file fin

cd . .
cd oracle\admin\agile9\create
recreateagile.bat

To create an additional agile schema with a d

Con

2. Make a backup of the existing database sche

Change to the oracle use

$ cd
4. Copy agile9db from the agile9tmp directory: 

$ cp ./agile9tmp/agile9db.sh
5. Edit the agile9db 

Change agile to the ne

Save and clos

Run agile9db: 

$ chmod u+x agile9db.sh
$ ./agile9db.sh
You are prompted to choose a database size. Ent
you created the database initially. 

The script creates several SQL scripts and Bourne sh

$ORACLE_BASE/ad

When the script finishes ru

$ cd $ORACLE_BAS
10. Run recreateagile: 

$ chmod u+x recreateagile.sh
$ ./recreateagile.sh

 

Deleting an Instance and the Database Files 

Before creating a new instance, you should d

1. Make sure the Oracle Listener (OracleO
(OracleServiceagile9) services are running. 

2. Start the Database Con



 

3. Select Delete a Database, and click Next. 
The instance you want to delete (Agile9) should appear in the Available Instances field. 

5. password (oracle), if necessary. 

 confirming that the 

8. irm th _HOME/dbs 

Confirm that the agile9-related password file, spfile, and init files in the 
base folder on Windows have been deleted. 

Note After dropping a database instance using the Database Configuration 

4. Select the instance. 

Type the username (sys) and 

6.  Click Finish. 

7. You are prompted to confirm the deletion, and then a message appears
instance has been removed. 

Conf at the agile9-related password file, spfile, and init files in the $ORACLE
folder on Solaris have been deleted. 

9. 
%ORACLE_HOME\data

Assistant, the TEMP tablespace must be removed manually. 
 

Database Recovery 

In th ckup to recreate a database 
that as
database

 For  of the 
ope

 

 last backup. 

 database, 

covery involves importing the database or schema from a 
cal backup, there is no roll forward involved. 

 

e case of failure, database recovery uses a previous database ba
 is  complete, accurate, and up-to-date as possible. Database recovery depends on the 

 backup method. Two backup methods are standard backup and logical backup.              

standard backup, including cold and hot backup, database recovery requires the use
rating system copy command to restore backed up datafiles. 

 If the database is running in NOARCHIVELOG mode, there are no backed up archive log 
files. Recovery is to restore a previously backed up data file, control file, initial parameter
file, and password file. No redo log files are applied and no database roll forward is 
needed. In this scenario, a database can be recovered up to the

 If the database is running ARCHIVELOG mode, database recovery is to restore previous 
backed up database files up to the last archived log files. When recovering a
these archived log files are applied and the database roll forward. In this scenario, a 
database can be recovered up to the point of database failure. 

 For a logical backup, a database re
previous export DMP file. For a logi

Database recovery can be performed by using Oracle Recovery Manager. For more database
recovery information, see the references suggested in Exporting the Database (on page 80). 

Using Oracle Recovery Manager 

You can use the Oracle Recovery Manager to perform an automatic recovery, restore the full 
database, restore a data file, or restore a control file. 

r Oracle Recovery Manager (RMAN) is that it can perform incremental 
covery. Incremental backup and recovery is much faster than a full 

ated 

The major advantage fo
database backup and re
database backup and recovery, especially for large database systems. RMAN is more complic
to setup compared with a standard backup. 
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Impo ing a script, make sure you have a current backup (export) of your Agile 
e), 

u

1.  folder on your Oracle server. For example, copy to 

2. n the computer where Oracle is installed, start SQL Plus in a command prompt window. 

3. ile and tartan).    

4. e ru  the 
SQL scrip

spool d:\A

Running Scripts 

rtant Before runn
database. For instructions on exporting (creating a DMP backup of your Agile databas
refer to your Oracle documentation or Help system.           

To r n an SQL script against an Oracle database on Windows: 

Copy the SQL script to the Agile9tmp
drive:\Agile9tmp. 

O

Type the login and password (the defaults are ag
Befor nning the script, create a spool file to record and contain the results from issuing

 t. At the SQL prompt type: 

gile9tmp\filename.lst    
 

For example: spool d:\Agile9tmp\averifyresults.lst   

Note The file with the LST extension is any filename that you want to use to identify 
the file that will contain these results. It is best and easiest to give the LST file 
the same name as the filename that is attached to the SQL file. 

For example, if the SQL file to
o

 be run is oracle_averify90.sql, then name the spool file 
racle_averify90.lst. You can also specify a drive or location other than what is shown in the 

5. mpt: 

le: @d:\agile9tmp\oracle_averify90.sql

previous example. 

The drive and location specified are where the spool file will be saved. 

Issue the command to run the SQL script by typing the following at the SQL pro

 @d:\Agile9tmp\filename.sql      
 

For examp

Note The @ symbol must be typed directly in front of this command line. 

The file with the SQL extension is the name of the
database. Depending on where the SQL file is loc

 specific SQL file to be issued against the 
ated on the server, you will also specify the 

er than the d:\agile9tmp shown in the 

Noti e th dication 
of “comm

6. At the SQ

7. Close the SQL Plus window and exit SQL Plus. 

drive and location, which could be something oth
example. 

c e process of the script being executed. When it is complete, there will be an in
it, complete.” 

L prompt, type the following: spool off   



 

Note In some cases where a change is being made to the database, you may need 
to stop and restart both Agile services for the change to take effect. If this is 
necessary, you will be advised at the time the script is provided. In the case of 
issuing scripts that do not make changes to the database scripts (for example, 
oracle_averify.sql scripts), restarting the Agile services is not necessary. 

8. Locate and open the spool file created in step 4, if necessary. 

The file can be opened within an application such as Notepad so that results can be viewed 
and printed, if necessary. 
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